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1. Nuclei Studio IDE 简介

一款高效易用的集成开发环境（Integrated Development Environment，IDE）对于任何 MCU 都

显得非常重要，软件开发人员需要借助 IDE 进行实际的项目开发与调试。ARM的商业 IDE 软件 Keil，

在中国大陆很多嵌入式软件工程师均对其非常熟悉。但是商业 IDE软件（譬如 Keil）存在着授权以

及收费的问题，各大 MCU 厂商也会推出自己的免费 IDE供用户使用，譬如瑞萨的 e2studio 和 NXP

的 LPCXpresso等，这些 IDE 均是基于开源的 Eclipse框架，Eclipse 几乎成了开源免费 MCU IDE 的主

流选择。Nuclei Studio IDE 正是芯来公司，基于 MCU Eclipse IDE 开发的一款针对芯来公司处理器核

产品的集成开发环境工具。

Eclipse平台采用开放式源代码模式运作，并提供公共许可证（提供免费源代码）以及全球发布

权利。Eclipse本身只是一个框架平台，除了 Eclipse 平台的运行时内核之外，其所有功能均位于不

同的插件中。开发人员既可通过 Eclipse项目的不同插件来扩展平台功能，也可利用其他开发人员

提供的插件。一个插件可以插入另一个插件，从而实现最大程度的集成。

Eclipse IDE平台具备以下几方面的优势。

社区规模大

Eclipse自 2001年推出以来，已形成大规模社区，这为设计人员提供了许多资源，包括图

书、教程和网站等，以帮助他们利用 Eclipse平台与工具提高工作效率。Eclipse 平台和相关项

目、插件等都能直接从 eclipse.org网站下载获得。

持续改进

Eclipse的开放式源代码平台帮助开发人员持续充分发挥大规模资源的优势。Eclipse 在以下

多个项目上不断改进。

平台项目——侧重于 Eclipse 本身。

CDT项目——侧重于 C/C++开发工具。

PDE项目——侧重于插件开发环境。
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源码开源

设计人员始终能获得源代码，总能修正工具的错误，它能帮助设计人员节省时间，自主控

制开发工作。

兼容性

Eclipse平台采用 Java语言编写，可在 Windows 与 Linux 等多种开发工作站上使用。开放式

源代码工具支持多种语言、多种平台以及多种厂商环境。

可扩展性

Eclipse采用开放式、可扩展架构，它能够与 ClearCase、SlickEdit、Rational Rose 以及其他

统一建模语言（UML）套件等第三方扩展协同工作。此外，它还能与各种图形用户接口（GUI）

编辑器协同工作，并支持各种插件。

Nuclei Studio已经充分与 Nuclei SDK整合，完全满足 SDK 的需要，可以方便快捷地新建模板工

程，快速修改工程设置选项。内置 Nuclei SDK源代码，可根据模板需求自动添加。

2. Nuclei Studio 更新说明

2.1.2024.02.dev版更新说明

本版本是开发版本（您下载到的链接内容随时可能会变更），本版本解决了 Nuclei Studio 2023.10

版中存在的缺陷，并优化了部分原有功能如 ETrace 特性，新增了一些功能如对 N100的支持、Dlink

的支持等，更好为满足客户评估和更新使用。

2.1.1.升级 Eclipse CDT版本

在 Nuclei Studio 2024.02.dev版本中基础的 Eclipse CDT版本，升级到了 Eclipse CDT 2023.12 版。

2.1.2.新增对 N100 的支持
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配合 N100核的发布，同步增加了对 N100 的配套支持。

2.1.3.新增批量转换 Gcc13 工程工具

在 2023.10版 Nuclei Studio 中，升级 GCC 13 后，当有大量工程需要转换时，单个转换效率低，

为方便开发者，提供了一个批量转换 GCC 13工具。具体内容参见第 8.1.3 章节内容。

2.1.4.优化和完善 Trace 功能

Nuclei Studio中 Trace 功能升级，实现了在 OpenOCD 模式下对单核应用、SMP多核应用、AMP

多核应用的支持，具体内容参见第 10章节内容；在 Dlink模式下，仅对单核应用支持。Trace功能

需要有对应 CPU IP 的支持，如需体验此功能，请与我们联系。

2.1.5.优化和完善 RVProf 功能

RVProf是芯来科技基于 CPU cycle model 开发的性能分析工具，具体内容参见第 11章节内容。

此功能需要有相应的 NPK 软件包支持，如需体验此功能，请与我们联系。

2.1.6.新增对 DLlink Debug 的支持

Dlink是芯来自主研发的调试解决方案，在本次版本中得到支持。此功能需要有相应的 Dlink 调

试器的支持，如需体验此功能，请与我们联系。

2.2.2023.10 版更新说明

本版本是一次比较重大的版本升级，集成了 Nuclei 2023.10版本的 Toolchain, QEMU, OpenOCD,

且 Eclipse CDT版本进行了升级，GCC 版本也做了重大迭代，升级到了 GCC 13, NPK部分也做了大量

的新功能的增加以支持 GCC或者 CLANG 的工程创建，并且增加很多新的 Configuration字段类型，

方便在 Project Wizard中更灵活的进行工程配置。

2.2.1.升级 Eclipse CDT版本

在 Nuclei Studio 2023.10版本中基础的 Eclipse CDT版本，升级到了 Eclipse CDT 2023.06版; Eclipse

CDT 2023-06 版本是 Eclipse 基金会 2023 年第二个季度同步版本，有 64 个参与项目，于 2023 年

6 月 14 日发布。
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参考地址：Eclipse IDE for C/C++ Developers

升级后打开之前版本创建的 workspace,会弹出不兼容的警告，使用时可能会有异常，建议更换

新的 workspace 目录。

图 2- 1 workspace弹出不兼容的警告

2.2.2.升级 build-tools版本

在Nuclei Studio 2023.10版将 toolchain中的 build-tools更新到 4.4版本，并额外增加了 bash.exe、

cp.exe、mv.exe、tar.exe工具。

https://www.eclipse.org/downloads/packages/release/2023-06/r/eclipse-ide-cc-developers
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图 2- 2build-tools更新到 4.4 版

2.2.3.支持 GCC 13和 Clang 17

在 Nuclei Studio 2023.10版本中实现了对 GCC 13的支持，相对于之前的 gcc10 版本 GCC 13 在对

RISC-V 指令扩展的支持更加完备，且在我们维护的版本中，支持完整的 RVV Intrinsic API v0.12版本。

同时 Nuclei Studio 2023.10版本中也实现了对 Clang 17的支持（参考地址：

https://releases.llvm.org/17.0.1/docs/RISCVUsage.html）。当然，如果有用户依然想使用 GCC 10 时行

项目开发，我们也保留了相关的配置，但是工具链并没有集成到 IDE 中，用户需要自行下载并放置

在 gcc10 目录中，参见里面的 README.txt，并且我们也提供了老版本采用 gcc10的 Nuclei Studio创

建的工程升级到 gcc13 工具链上，具体使用可以参考章节 8 内容。Nuclei RISC-V Toolchain 2023.10

更详细的说明，请参阅: https://github.com/riscv-mcu/riscv-gnu-toolchain/releases/tag/nuclei-2023.10

图 2- 3GCC 和 Clang 的目录结构

https://releases.llvm.org/17.0.1/docs/RISCVUsage.html
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图 2- 4 工程对 GCC 13 的支持
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图 2- 5 项目对 Clang 17 的支持

2.2.4.RISC-V指令扩展使用变更

因 gcc 和 clang的变更，在扩展的使用上，有了较大的变化。原来的 bpkv 扩展与新的规则对应

关系如下，更详细的说明，请参阅

https://doc.nucleisys.com/nuclei_sdk/develop/buildsystem.html#arch-ext

 b -> _zba_zbb_zbc_zbs

https://doc.nucleisys.com/nuclei_sdk/develop/buildsystem.html#arch-ext
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 p -> rv64: _xxldsp, rv32: _xxldspn3x for n300, _xxldspn1x for n900

 k -> _zk_zks

 v -> rv32f/d : _zve32f, rv64f: _zve64f, rv64fd:

v

以 N307FD + B + V + Nuclei DSP with N1 extension为例，创建一个使用扩展的应用，在创建工

程的引导中，需要 Nuclei ARCH Extensions中填入对的扩展字段，如需要使用 bpv 扩展，根据以

上规则，需要填入_zba_zbb_zbc_zbs_zve32f_xxldspn1x，生成的工程中，可以看到在工程的 Nuclei

Settings和 C/C++ Build->Settings->Target Processor中均有体现，同时在 QEMU的配置中也会有

相对应的设置。
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图 2- 6 创建工程时使用 RISC-V 扩展

图 2- 7 项目中对 RISC-V 扩展的支持
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图 2- 8 Nuclei Settings 中对 RISC-V 扩展的支持

图 2- 9 QEMU 中对 RISC-V 扩展的支持
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2.2.5.NPK 包的使用变更

为了支持 GCC 13和 Clang 17，Nuclei SDK 包升级到了 0.5.0 版本，使用 SDK包创建工程时，用

户可以根据需要，选择创建一个 GCC 13或者 Clang 17的工程。因为版本变动较大，0.5.0 之前的 sdk

可能有部分功能在 Nuclei Studio 2023.10版中使用异常，所我们提供了工具帮助您快速进行工程迁

移和升级，请自行备份老版本的工程，具体可能参考章节 8.1 内容。

图 2- 10 创建工程时选择合适的工具链

另外 Nuclei Studio 2023.10中会对 npk在线组件包做适配版本的校验（上传阶段需要填写测在

什么版本的 Nuclei Studio上测试使用），不同的组件包所适配的 Nuclei Studio版本号会在 Package

Management页面展示，在下载安装的时候如果版本不匹配，会给与提示，但是导入离线包不会有

任何提示，请自行甄别是否被所使用的 Nuclei Studio IDE 版本所支持，具体如下。
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图 2-11 组件包所适配的 Nuclei Studio版本号

2.2.6.升级 OpenOCD

OpenOCD 版本升级至 2023.10版，增加了一些额外的调试特性，例如 查看 cpu信息，etrace

实验性的支持。关于 OpenOCD 变更更详细的说明，请参阅：

https://github.com/riscv-mcu/riscv-openocd/releases/tag/nuclei-2023.10

2.2.7.升级 QEMU

在 Nuclei Studio 2023.10中集成 Nuclei QEMU 2023.10版本，而 Nuclei QEMU 2023.10基于 QEMU

8.0进行二次开发（参考地址：https://wiki.qemu.org/ChangeLog/8.0）。本版本的 QEMU 和 2022.10

版本使用方面有比较大的变化，不再支持 gd32vf103_rvstar 这块开发板，转而只支持 Nuclei EvalSoC,

可以配置 Nuclei SDK/Nuclei Linux SDK无缝使用。且支持的 machine 由 nuclei_n/nuclei_u 转而统一变

为 nuclei_evalsoc。关于详细 Nuclei QEMU 更详细的说明，请参阅：

https://github.com/riscv-mcu/qemu/releases/tag/nuclei-2023.10

https://github.com/riscv-mcu/riscv-openocd/releases/tag/nuclei-2023.10
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图 2- 12 QEMU 8.0 所在的目录

2.2.8.新增了 elf 文件查看器

在 Nuclei Studio 2023.10新增 elf 文件编辑器，方便用户查看编译后产生.elf、.o 文件。

图 2- 13 elf 文件编辑器查看.elf 文件
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图 2- 14 elf 文件编辑器查看.o 文件

2.2.9.新增 Code Coverage 和 Profiling 功能

在 Nuclei Studio 2023.10新增了对 Code Coverage和 Profiling 功能的支持，具体参考第 9 章节内

容。

2.2.10.新增 trace 功能

在Nuclei Studio 2023.10实验性新增了 trace功能，因使用此功能需要带有Nuclei Trace IP的CPU，

如需体验此功能，请与我们联系。

2.2.11.Nuclei Settings 功能优化

为了应对更个性化的配置，我们修改了 Nuclei Settings 部分功能。

Nuclei Studio 2023.10去掉了原来的 B/P/K/V 的单选框，换成 Other Extensions 输入框，用户可

以根据自己的需求自定义填写。而关于 B/P/K/V的使用，可以参考章节 2.1.4内容。
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图 2-15 Nuceli Settings 页面修改

Nuclei Studio 2023.10去掉了原来的 Select C Runtime Library 单选框，在项目中如果需要使用，

可能过项目配置传入的“--specs=”选项，或者 Libraries 选项,来实现。
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图 2-16 Select C Runtime Library 在新版 IDE中已不存在

Nuclei Settings 增强了其通用性，使它不仅仅能对 Nuclei 的工程进行快速修改，也新增以对通

用 riscv 和 arm创建的 static 和 shared的 library 工程的支持。下面为 shared对应示图。

图 2-17 Shared 项目 Nuclei Settings(Arm)

图 2-18 Shared 项目 Nuclei Settings(Riscv)
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2.2.12.新增指定工作空间快速打开

类似双击项目下的*.nuproject文件可快速打开 Nuclei Studio并导入该项目，现在 Nuclei

Studio会在使用过的工作空间目录下创建 work.nuworkspace 文件，双击该文件可以直接打开 Nuclei

Studio，但该功能暂时只支持 windows版本。这个功能需要解压 IDE 后，在 windows 上执行 install.bat

来设置文件关联。

图 2-19 work.nuworkspace 文件

2.3.2022.12 版更新说明

Nuclei Studio自 2021.09 版后，将 IDE 与 SDK完全分离，将采用全新的 Nuclei Package(NPK)的包

管理的方式进行模板工程的管理和使用，方便用户进行不同 SDK的导入并且在 IDE 上创建示例工程

并使用，针对 Nuclei SDK 和 HBird SDK 以及我们公司的 SoC IP 产品提供的 SDK，均可以打包成 Zip包

的方式以通过 Nuclei Package Management方式进行导入使用。
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3. Nuclei Studio 下载与安装

3.1. Nuclei Studio IDE下载

为了方便用户快速上手使用，本文档推荐使用预先整理好的 Nuclei Studio IDE 软件压缩包。芯

来公司已经将该软件压缩包上传至公司网站，具体地址为 https://www.nucleisys.com/download.php，

如图 3- 1所示。

用户可以在芯来科技公司网站的“下载中心”，根据用户开发环境，下载对应 Windows 或 Linux

的 Nuclei Studio压缩包（注意：芯来科技公司网站的下载中心，其内容会不断更新，用户请自行选

择使用最新版本或继续使用当前版本）。

目前已在 Win 10 64位系统，Ubuntu 18.04/20.04 和 Redhat7.6 64位版本上验证测试，推荐使

用以上版本的系统。

https://www.nucleisys.com/download.php
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图 3- 1Nuclei Studio IDE 软件包的下载界面

3.2. Nuclei Studio IDE安装

当完成 Nuclei Studio IDE 压缩软件包下载，解压后包含若干文件如图 3- 2（解压路径中不可包含

中文），分别介绍如下。

Nuclei Studio软件包

该软件包中包含了 Nuclei Studio IDE的软件。注意：具体版本以及文件名可能会不断更新。

HBird_Driver.exe（2021.02 版本起不再提供）

仅 Windows 版提供，此文件为芯来蜂鸟调试器的 USB 驱动安装文件。

当在 Windows 环境下，使用该调试器时，需要安装此驱动使该 USB 设备能够被系统识别。



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 38

由于 2021.02版本中更新的 openocd引入了免驱功能。

SerialDebugging_Tool（2021.02 版本起不再提供）

仅 Windows 版提供，此文件为“串口调试助手”软件。此软件可以用于后续软件示例调试时通

过串口打印信息。

图 3- 2Nuclei Studio IDE 压缩包文件内容

3.3. Nuclei Studio IDE启动

启动 Nuclei Studio的要点如下（windows 和 linux 均按照如下操作）：

直接双击 Nuclei Studio IDE文件包中 Nuclei Studio文件夹下面的可执行文件，即可启动 Nuclei

Studio，如图 3- 3所示。

第一次启动 Nuclei Studio后，将会弹出对话框要求设置 Workspace目录路径，该目录将用于

存放后续创建的项目工程文件，如图 3- 4所示。

设置好 Workspace 目录之后，单击“Launch”按钮，将会启动 Nuclei Studio。第一次启动后的

Nuclei Studio界面如图 3- 5所示。

2021.02版本 Nuclei Studio 默认关闭了 Launch Bar，请参照 10.10.1开启 Nuclei Studio 中的

Launch Bar功能，方便快速编译调试和下载。
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图 3- 3 双击“Nuclei Studio.exe”启动 Nuclei Studio

图 3- 4 设置 Nuclei Studio 的 Workspace 目录
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图 3- 5 第一次启动 Nuclei Studio界面

4.Nuclei Studio NPK 功能

Nuclei Studio 中内建了对 Nuclei Package（NPK）功能的完整支持，方便开发者或者创建不同的

软件开发包，并且通过 Nuclei Package Management方式导入到 Nuclei Studio 中使用，如果是 CPU IP

客户，可以将自己的芯片 SDK略作改造以支持 NPK，并导入到 Nuclei Studio中使用，如果是 SoC IP

客户，可以将提供的 SDK打包成 Zip包，导入使用，如果是开发者，也可以依赖某个特定的 NPK，

创建对应的 BSP包或者 APP 包并提供给第三方使用，关于 NPK 功能的详细介绍，以及后续更新说

明参见 https://github.com/Nuclei-Software/nuclei-sdk/wiki/Nuclei-Studio-NPK-Introduction。通过在原

有的 SDK中引入 npk功能，编写 npk.yml 可以达到 Project Wizard功能的部分定制化。

开发者要使用 Nuclei Studio进行工程的创建，需先将对应的 SDK NPK Zip 包安装到 IDE中，方

可根据不同的开发板快速新建不同的模板工程，并根据不同的模板添加需要的 SDK源码，根据选项

生成不同的编译链接选项设置。

https://github.com/Nuclei-Software/nuclei-sdk/wiki/Nuclei-Studio-NPK-Introduction
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4.1.通过 NPK 创建工程

本章将在 RVSTAR开发板上，以新建和修改 GD32VF103的工程为例快速介绍 Nuclei Studio功能，

RVSTAR开发板开发需要使用 nuclei_sdk的 npk包，详细的流程请参考之后的章节。

4.1.1.NPK 软件包管理

在 Nuclei Studio中最大的更新，就是将 npk 云端化，用户直接在 Nuclei Studio中就可以下查

看到所有的 npk并自行安装，在菜单栏选择“RV-Tools-->Nuclei Package Management”在弹出

的Nuclei Package Management管理页进行 npk管理如图 4-3。在 Nuclei Package Management

页面，先点击一下 Refresh获取最新的 npk信息，npk 安装前状态为 Not Installed然后选中

自己想要安装的 npk,点击 Download 进行安装，本教程安装 sdk-nuclei_sdk的 0.3.7版本，

最新版本为 0.5.0，请使用最新版本进行安装，最新版本支持 gcc13 工具链，之前版本支持

的是 gcc10，安装完成后 npk 状态变为 Installed。

图 4-1 进入 SDK Manage
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图 4-2 导入资源包

图 4-3 资源包管理
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图 4-4 NPK 安装成功

4.1.2.创建 NPK 示例工程

新建一个工程，可以在菜单栏中，选择“File --> New --> New Nuclei RISC-V C/C++ Project”，如 图

4- 5。也可以在 Project Explorer 视图中选中“New Nuclei RISC-V C/C++ Project”
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图 4-5 使用菜单栏创建项目

图 4-6 使用菜单栏创建项目

如图 4-7 所示，在弹出的窗口中可以不同的厂商提供的不同版本的 SDK,选种某一 Board下的

SDK,看到相关 SoC及 Board的介绍。这里以 RVSTAR开发板为例，所以这一项选择

“GigaDevice->GD32VF103->Nuclei GD32VF103 RVSTAR Board->sdk-nuclei_sdk@0.5.0” 。点击
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“Next”进入下一步。（注意：这里的 sdk版本号会随着版本迭代做相应的更新，并且也可

能依赖特定版本的 Nuclei Studio使用）

图 4-7 选择建立项目类型
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进入具体的项目配置页如图 4-8 所示，因为 RVSTAR的内核是固定的 N205，其对应的 arch和

abi分别是 rv32imac 和 ilp32，所以 Core选项不能修改。同样，RVSTAR 开发板仅支持一种

FLASHXIP下载模式，所以 DOWNLOAD这一选项也不能修改。点击“Finish”完成工程创建。

在 2023.10版本，增加了对 Arm项目的支持。

图 4-8 选择程序模板及相关设置项

Nuclei Studio可以根据不同的工程模板添加不同的 SDK源码，例如 FreeRTOS 模板工程会

添加对应的 OS 内容，Demo_dsp模板工程可以添加 NMSIS 库文件。关于 NMSIS 详细信

息请参考（https://doc.nucleisys.com/nmsis/index.html）。这里以 Demo_dsp为例，“Project

Example”选择“Nuclei NMSIS DSP Library Demo”。因为使用 dsp工程，需要添加 NMSIS

库，所以“Libraries”选择“NMSIS DSP Library”。

Nuclei Studio可以根据新建工程时的选项自动设置工程的选项。这里选择使用浮点打印，

所以“NEWLIB”选择“newlib nano with printf float”。之后一直选择“Next”直到“Finish”。

https://doc.nucleisys.com/nmsis/index.html


本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 47

4.1.3.SDK Configuration Tools 更改工程配置

在 Nuclei Studio可以快速修改工程的设置选项，提供了“SDK Configuration Tools”工具，Nuclei

Studio IDE 2022.12版后，对“SDK Configuration Tools”工具进行了重构，变更为用户体验更好的 Nuclei

Settings 菜单。

4.1.3.1 SDK Configuration Tools

新建好的工程如图 4-9所示，单击要修改的工程名，右击打开右键菜单，选择“SDK Configuration

Tools”打开设置选项工具。如图 4-10，如果要修改编译优化等级，修改“Optimization Level”为“None

（-O0）”，点击“Save”修改选项。如图 4-11修改成功后在修改后的工程处右击打开右键菜单，选择

“clean”清除一下工程，再点击锤子图标编译工程。

注意：SDK Configuration Tools 修改编译配置后对调试配置（Debug Configurations）不生

效，请手动修改对应的调试配置。

注意：后续版本中，将不再维护“SDK Configuration Tools”功能，由 Nuclei Settings菜单功

能替代。

图 4-9 打开 SDK 设置工具
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图 4-10 修改工程设置

图 4- 11 清理工程并重新编译

4.1.3.2 Nuclei Settings菜单

为了更好的用户使用体验，Nuclei Studio IDE 2022.12 版对“SDK Configuration Tools”进行了重构，
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新创建的工程中会多一个 Nuclei Settings 菜单，双击 Nuclei Settings 菜单，将打开工程配置工具其在

功能上与“SDK Configuration Tools”无异，在 2023.10 版本及其后续版本，SDK Configuration Tools 将

直接打开这个 Nuclei Settings 界面。

图 4-12 Nuclei Settings 菜单

4.2.通过 NPK 导入工具

NPK 包除了可以导入 SDK,还可以方便的导入各种工具包，来扩展 Nuclei Studio的能力，2022.08

版本的 Nuclei Studio增加 NPK Tools 的支持，为增加组件包的可扩展性，以及在编译和调试上使用

更便捷，增加类型为 tool 的 npk 组件包。tool 组件包可包含 gcc,qemu,cmlink-gdb等内容，以 zip包

的形式导入到 IDE去使用。

以 tool-cmlink包为例，一个工具包中有该工具的执行文件及 npk.yml，开发者在 npk.yml文件

中对该工具做了一些简单的描述，如工具包的开发者、版本、支持的操作系统、可执行文件的路径

等，包结构和 npk.yml 内容如下示例。然后将工具包压缩成一个 zip 文件，可以参考 4.1.章的内容，



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 50

将 npk tools 导入到 ide中，或共享到 www.rvmcu.com网站上。

-bin

-bin\cmlink_gdbserver.exe

-npk.yml

图 4-13 npk.yml文件示例

在 Nuclei Package Management管理页中同样可以对 npk tools 进行管理，下载该组件包后，打

开任意调试界面，点击 Variables 可以查看到该 npk tools 对应的参数，直接选中对应的参数就可以

使用该工具了。

http://www.rvmcu.com
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图 4-14 Variables 查看 npk tools 对应参数
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图 4-15 Variables 查看 npk tools 对应参数

一般我们在 npk tool中为该组件包扩展变量有 4 个，每个包存在一个包路径，引用为 npk名称

-版本号，例如${tool-cmlink-1.0.0}

其他变量的引用为 npk名称-版本号-变量名，例如

${tool-cmlink-1.0.0-proxy},${tool-cmlink-1.0.0-system_proxy}

当变量的 system值为 true 时，额外新增一个不带版本号的变量，取最高版本的该变量，例如

${tool-cmlink-system_proxy}
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5. 创建工程

这里以开发板为 Nuclei FPGA Evaluation Board，评估处理器内核为 N307(rv32imafc)为例，详细

介绍 Nuclei Studio中创建项目的常见方式。

在 Nuclei Studio IDE 创建项目可以有以下几种常见方式：

使用模板自动创建项目：

这是最简单快捷的方式，目前模板项目功能依赖于 Nuclei Studio NPK 功能，在导入对应的 SDK

NPK Zip 包，即可在 Nuclei Studio 上进行模板工程的创建。芯来科技提供了 Nuclei SDK、

HBird SDK、SoC IP SDK 的 NPK Zip 包，均可导入到 IDE中进行工程的创建和使用。

从已有项目直接导入创建新项目：

这是最常见的方式，譬如，用户 A 可以将已有项目的文件夹直接进行打包保存，然后进行分

享传播，用户 B可以在另外的电脑上直接导入该项目，从而以此为基础创建新的项目，

在此基础上直接使用或者开发修改。

无模板手动创建项目：

这是最繁琐的方式，该方法除了创建项目之外，还需要手动设置各种选项和路径。由于该方

式比较繁琐，所以在实际工作中较少使用，但是通过该方式的详细讲解，用户可以详

细了解如何配置各中选项和路径。

基于已有的 Makefile 创建项目：

这种方式比较适合于已经采用 Makefile或者其他编译工具的项目，提供一种在 IDE中编译工

程，清理工程，调试工程的方式。在不修改编译系统的基础上，提供良好的 IDE 调试
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环境。

下文将对这几种方式分别进行介绍。

5.1.通过模板自动创建项目

本节将介绍如何使用模板自动创建项目的方式，在 Nuclei Studio IDE 创建一个简单的 Hello

World项目，详细步骤如下。

新建一个工程，可以在菜单栏中，选择“File --> New --> New Nuclei RISC-V C/C++ Project”，如

图 5-1。也可以在 Project Explorer视图中选中“New Nuclei RISC-V C/C++ Project” ，如图 5-2。

图 5- 1 从菜单创建项目
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图 5-2Project Explorer 视图创建项目

如图 5-3所示，在弹出的窗口中选择项目类型，这里我们在 Nuclei FPGA板，内核是 N307，

SDK为 nuclei_sdk@0.3.9 版本来做一个测试开发，选对对应的 Board下的 SDK, 点击“Next”

进入下一步。
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图 5-3 选择建立项目模型

如下图所示，在弹出的窗口中设定如下参数（注意：此页面是通过 NPK Configuration字段自

动解析并生成的页面，不同的 SDK 或者不同的开发板或者不同的例子都可能会有不同的选

项页面，请注意）。

Project name：项目命名。这里设置为“1_helloworld”

Project Example：选 Helloworld。

Toolchains：我们使用 Nuclei GUN Toolchain。

我们的内核是 N307，所以“Core”选择“N307”。

蜂鸟开发板支持三种下载模式，以下为每种下载模式的简介，这里我们选择 ILM 模式。

ILM 下载模式程序将被直接下载在 MCU 的 ILM 中，并从 ILM开始执行。ILM 由 SRAM

组成，会掉电丢失。
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FLASH 下载模式程序代码段的物理地址约束 Flash 区间，将代码段的逻辑地址约束在

ILM的地址区间，意味着程序将被直接下载在 MCU 的 Flash中，但是上电后要通过

引导程序将代码段搬运到 ILM中，然后从 ILM 中开始执行。程序被烧写在 Flash 中，

不会掉电丢失。

FLASHXIP 下载模式程序代码段约束 Flash区间，意味着程序将被直接下载在 MCU 的

Flash中，并直接从 Flash开始执行。程序被烧写在 Flash 中，不会掉电丢失。

其他各项可以按需进行配置

点击“Finish”完成工程创建。
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图 5-4 新建项目及模板选择

如下图所示，使用模板自动创建 Hello World项目已经完成。

图 5-5 完成模板创建项目

用户可以直接使用菜单栏“Project—> Build Project”或“ ”按钮，来对该项目进行编译，编译

后如图 5- 6。
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图 5- 6 完成项目编译

如图 5- 7所示，在 Hello World项目自动生成过程中，其对应的 OpenOCD 配置已经同步完成。

在项目编译完毕后，用户可以右键点击项目列表“Hello World”，点击“Debug As —>Debug

Configurations”开启调试配置面板进行查看。Debug 与 Run使用相同的配置文件，所以也可

通过“Run As —>Run Configurations”打开。
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图 5- 7 开启调试配置面板

如图 5- 8所示，用于调试使用的配置文件“Hello World_Debug_OpenOCD”已经自动生成。关于

使用芯来蜂鸟调试器结合 OpenOCD 进行下载和调试的方法，可以查看第 7章进行详细了

解。
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图 5- 8 自动生成的 OpenOCD 配置

5.2.通过应用关联文件导入工程

本节将介绍如何通过Nuclei Studio IDE的关联文件，将一个Hello World项目导入到 IDE中。Nuclei

Studio IDE 2022.12版中，新增了应用文件关联的支持，可以将 IDE 的启动路径注册到系统注册表中，

然后通过特定的文件，可以实现 IDE的启动、工程导入等功能，极大的方便了 Nuclei Studio IDE用

户在使用过程中，对工程的分享和快速导入。

5.2.1.将 Nuclei Studio IDE 写入到注册表

下载 Nuclei Studio IDE 2022.12 版，在安装包中多了两个文件 install.bat/install.sh,在 windows 系

统下，双击 install.bat,因为这里需要写入注册表，所以需要一个用户授权,授权后安装成功；在 linux

系统下，需要在 shell命令下执行 install.sh文件。
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图 5-9 install.bat/install.sh 文件

图 5-10 用户授权

5.2.2.通过应用关联文件导入工程

Nuclei Studio IDE 2022.12 版创建工程 test，在工程中会有一应用关联文件 test.nuproject，如果
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ide的启动路径已写入注册表，双点 test.nuproject文件，系统会自动启动 Nuclei Studio IDE并将 test

工程导入到 IDE中。

图 5-11 应用关联文件 test.nuproject

5.3.从已有项目直接导入创建新项目

本节将介绍如何使用 IDE从已有项目直接导入创建新项目，本文以 N307的项目包为例进行导

入，项目包存放在（https://github.com/riscv-mcu/Nuclei-Studio_IDE-Project-Package）。如图 5- 12所

示，如需其它项目包请与芯来科技联系。

在基于 Windows 的 Nuclei Studio IDE开发环境中，如果用户使用“无模板手动创建工程”，也需

要加载此项目包中的 nuclei-sdk文件夹，相关内容会在下一节中具体介绍。

图 5- 12 位于 github 上面的项目包

https://github.com/riscv-mcu/Nuclei-Studio_IDE-Project-Package
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将 nuclei-eclipse_demo.rar 压缩包下载解压后，内容如图 5- 13所示，分别为：

图 5- 13 选择导入的项目

项目包的描述文件.setting，.project和.cproject

项目包的 Debug 设置文件*.launch

nuclei_sdk文件夹

该文件夹下存放部分 SDK源代码。

application文件夹

此文件夹包含 hello_world样例程序的 main函数源代码。

下一步导入下载好的项目包，导入步骤如下：

在菜单栏中选择“File—>import”。

如图 5- 14所示，选择“Existing Project into WorkSpace”后，点击“Next”。
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图 5- 14 选择导入的方式

点击“Browse”，选择需要导入的项目路径，如图 5- 15所示，
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图 5- 15 选择需要导入的项目

需要的导入的项目成功被 IDE 识别，点击“Finish”如图 5- 16所示

图 5- 16 识别出要导入的项目
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 在 IDE 的项目资源管理器中显示导入项目的目录结构如图 5- 17所示。已有项目默认为 N307

的编译选项，Nuclei SDK仅包含 helloworld使用到的文件。需要更多的 Nuclei SDK源码请访

问 Github（https://github.com/riscv-mcu/hbird-sdk）获取源码。

图 5- 17 显示项目的文件结构

5.4.无模板手动创建项目

本节将介绍如何使用手动方式在 Nuclei Studio IDE 创建一个用户自定义的 Hello World项目（不

建议使用，建议使用章节 4.1 NPK方式）。开发板为 Nuclei FPGA Evaluation Board，内核为 N307。

该方法除了创建项目之外，还需要手动设置各种选项和路径，详细步骤如下。

5.4.1.手动创建项目

在菜单栏中选择“File—> New—> C/C++ Project”。如图 5- 18所示。

如图 5- 19所示，在弹出的窗口中设定如下参数。

Project name：项目命名。

Use default location：如果勾选了此选项，则会使用默认 Workspace文件夹存放此项目。

Project type：选择“Hello World RISC-V C Project”。

然后点击 Next进入下一步

如图 5- 200所示，在弹出的窗口中设置 Hello World项目的基本信息。



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 68

确保“Source”选项内容为空，直接单击“Next”进入下一步。

如图 5- 211所示，在弹出的窗口中设置项目的调试或者发布属性。

该步骤可以使用默认信息不做任何修改，直接单击“Next”进入下一步。

在弹出的窗口中设置项目所使用的 RISC-V 工具链。

此处不要配置，直接选择“Finish”，至此便完成了 Hello World项目的创建。

创建完成的 Hello World项目界面如图 5- 22所示。

新建一个 application文件夹。如图 5- 23，在工程处右击选择 New—> Folder，输入 application，

点击“Finish”完成新建工程，如图 5- 24。将 main.c 拖入 application 文件夹完成文件分类。

图 5- 18 新建 C/C++ Project
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图 5- 19 设置 C Project 项目名和类型
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图 5- 20 设置 Hello World项目的基本信息
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图 5- 21 设置项目的调试或者发布属性
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图 5- 22 创建完成 Hello World 项目的界面
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图 5- 23 打开新建文件夹

图 5- 24 完成新建文件夹

5.4.2.配置项目的 nuclei_sdk

本节介绍如何将 nuclei_sdk加入到项目中，SDK 的具体内容本文不做详细介绍，可以参考

https://doc.nucleisys.com/nuclei_sdk/index.html。如果需要使用 SDK的其他源文件，请到 Github获

取全部的 Nuclei SDK源码（这里以 0.3.9 版本为例），链接如下：

https://github.com/Nuclei-Software/nuclei-sdk/releases 。本节仅介绍将 nuclei_sdk 中 helloworld需要

的文件加入到项目的步骤，如果使用新版本的 SDK，对应的目录结构可能有所调整，请自行解决，

具体步骤如下：

进入 Nuclei Studio的 2_helloworld 项目，按照如下步骤添加 nuclei_sdk源文件。

如图 5- 25 所示，在 Project Explorer 栏中选中 2_helloworld项目，单击鼠标右键，选

择“Properties”打开工程设置页面。

https://doc.nucleisys.com/nuclei_sdk/index.html
https://github.com/Nuclei-Software/nuclei-sdk/releases
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如图 5- 26 所示，在弹出的窗口中单击“Resource”，在右侧的 Location栏目中单击其

最右侧的箭头图标 ，则会弹出文件窗口进入 2_helloworld项目的文件夹位置。

将图 5- 12 中介绍的 nuclei-eclipse_demo.rar 压缩包中的 nuclei_sdk文件夹复制放于

2_helloworld项目的目录下，如图 5- 27所示。

回到 Nuclei Studio，在 Project Explorer 栏中选中 2_helloworld项目，单击鼠标右键，

选择“Refresh”，如图 5- 28所示。

Refresh之后 2_helloworld项目的下便可以看到 nuclei_sdk文件夹，如图 5- 29所示，

至此便完成了 nuclei_sdk源文件的导入。

图 5- 25 打开工程设置选项页面
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图 5- 26 在弹出窗口进入 hello_world 项目的文件夹位置

图 5- 27 添加 nuclei_sdk 文件夹



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 76

图 5- 28 刷新工程
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图 5- 29 新建项目目录下的文件夹

5.4.3.配置项目的编译和链接选项

为了使项目源代码能够被正确编译，需要配置编译和链接选项。

注意：本节中设置的编译与链接选项均为 GCC 工具链的常用选项，与在 Linux 环境中使用时的

同名选项含义一致，本节在此不做赘述介绍。

配置编译与连接选项的步骤如下：

在 Project Explorer栏中选中 hello_world 项目，单击鼠标右键，选择“Properties”。

在弹出的窗口中，展开 C/C++ Build 菜单，单击“Setting”，在右侧的 Tool Settings 栏目中进行

设置。

如图 5- 300所示，选中 Target Processor，我们的内核是 N307，因此需要按照图所示勾选配置

选项，分别如下。
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Architecture：选择 RV32I。

Multiply extension（RVM）：需勾选。

Atomic extension（RVA）：需勾选。

Compressed extension（RVC）：需勾选。

Integer API：选择“ILP32”。

Floting Point ABI：选择 single precision

Code model：选择“Medium Any”。

单击右下角的“Apply”按钮。



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 79

图 5- 30 配置 Target Processor 选项

如图 5- 311 所示，选中“Optimization”，按照图所示勾选配置选项。

Optimization Level：选择 Optimization Most (-O2)。

依次勾选：

Function Sections (-ffunction-sections)

Data Sections (-fdata-sections)

No common unitialized (-fno-common)

注意：上述选项均为通用的 GCC 编译优化选项，请用户自行查阅 GCC 手册了解其

含义。
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单击右下角的“Apply”按钮。

图 5- 31 配置 Optimization 选项

如图 5- 32 所示，选中 Debugging，按照图中所示勾选配置选项，分别为：

Debug Level：选择 Default (-g)。

单击右下角的“Apply”按钮。
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图 5- 32 配置 Debugging 选项

选中 GNU RISC-V Cross C Linker 的 General。

如图 5- 33 所示，按照如下步骤设置链接器的所需的链接脚本。

选中右上角的加号按键。

在弹出的窗口中单击“Workspace”按钮。

这里我们使用 HummingBird评估板，所以可以选择 ILM 下载模式对应的

gcc_hbird_ilm.ld文件。在弹出的窗口中选择 Nuclei Studio文件包中的

nuclei_sdk/SoC/hbird/Board/hbird_eval/Source/GCC文件夹下 gcc_hbird_ilm.ld文件。

其他下载模式切换此处文件，各文件详细介绍如下，可根据自己的实际情况选择。

gcc_hbird_ilm.ld脚本将程序代码段约束在 ILM 的地址区间，意味着程序将被直接
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下载在 MCU 的 ILM中，并从 ILM 开始执行。ILM 由 SRAM组成，会掉电丢失。

gcc_hbird_flash.ld 脚本程序代码段的物理地址约束 Flash区间，将代码段的逻辑

地址约束在 ILM的地址区间，意味着程序将被直接下载在 MCU 的 Flash中，但

是上电后要通过引导程序将代码段搬运到 ILM中，然后从 ILM 中开始执行。

gcc_hbird_flashxip.ld 脚本程序代码段约束 Flash 区间，意味着程序将被直接下载

在 MCU 的 Flash中，并直接从 Flash开始执行。程序被烧写在 Flash 中，不会

掉电丢失。

用户可以按照自己的需求选择合适的链接脚本。本节示例选择 gcc_hbird_ilm.ld

作为演示。

设置完毕请单击右下角的“Apply”按钮。

图 5- 33 配置链接脚本
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如图 5- 34 所示，按图所示勾选配置选项，分别如下。

Do not use standard start files (-nostartfiles) 。

Remove unused sections (--gc-sections)。

单击右下角的“Apply”按钮。

注意：上述选项均为通用的 GCC 链接选项，请用户自行查阅 GCC 手册了解其含义。

图 5- 34 配置链接的 General 选项

如图 5- 35 所示，选中 GNU RISC-V Cross C Linker的 Miscellaneous，按照图所示勾选配置选项。
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勾选“Use newlib-nano”。

因为 Hello World程序的 Printf不需要打印浮点数，所以不要勾选“Use float with nano printf”。

单击右下角的“Apply”按钮。

图 5- 35 配置链接的 Miscellaneous 选项

5.4.4.配置项目的包含路径和文件

为了能够正确编译 nuclei_sdk文件夹中的源文件，需要按照如下步骤配置项目的包含路径和包

含文件。

如图 5- 25 所示，在 Project Explorer栏中选中 hello_world 项目，点击鼠标右键，选择
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“Properties”。

在弹出的窗口中，展开 C/C++ Build 菜单，单击“Setting”，在右侧的 Tool Settings 栏目中进行

设置。

如图 5- 36所示，选中 GNU RISC-V Cross C Assembler 的 Includes，按照图中所示配置包含文件，

步骤如下。

在 Include paths 栏目单击加号键。

在弹出的窗口中单击“Workspace”，弹出 Folder selection窗口。

在 Folder selection窗口中选择项目的 nuclei_sdk目录下的 NMSIS>Core>Include文件夹。

在右下角单击“Apply”完成配置。

采用上述方法，依次添加 nuclei_sdk目录下的 SoC>hbird>Board>hbird_eval>Include，

SoC>hbird>Common>Include和 SoC>hbird>Common>Source>Stubs 文件夹作为包含路径，并

采用同样的方法为 GNU RISC-V Cross C Compiler 的 Includes 栏目设置包含路径。设置完成后

的界面如图 5- 37所示。
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图 5- 36 设置 GNU RISC-V Cross C Assembler 的 Includes 栏目包含路径



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 87

图 5- 37 设置 GNU RISC-V Cross C Compiler 的 Includes 栏目包含路径

5.5.基于已有的 Makefile创建项目

本节将介绍如何使用已有的 Makefile在 Nuclei Studio IDE创建一个使用 Makefile 的 Hello World

项目。开发板为 Nuclei FPGA Evaluation Board，内核为 N307。请先下载 Nuclei SDK，Github链接为：

https://github.com/Nuclei-Software/nuclei-sdk。该方法除了创建项目之外，还需要手动设置各种选项

和路径，这里以 helloworld为例，详细步骤如下。

5.5.1.手动新建项目

在菜单栏中选择“File—> New—> Makefile Project with Existing Code”。如图 5- 38 所示。

如图 5- 39 所示，在图标 1处输入工程名，这里我们命名为 nuclei-sdk。在图标 2 处输入 SDK的

实际路径。在图标 3处选择“RISC-V Cross GCC”。点击图标 4 完成新建项目。

https://github.com/Nuclei-Software/nuclei-sdk
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图 5- 38 新建基于 Makefile 的工程
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图 5- 39 设置工程选项

5.5.2.设置 Makefile 路径和 Build 选项

右击新建好的工程，选择“Properties”打开设置页面，如图 5- 400，选择“C/C++ Build”，在“Build

Location”中选择“Workspace”。在弹出的弹窗中选择“application –> baremetal –> helloworld”点击“OK”

再点击“Apply”保存。

图 5- 40 配置 Makefile 路径

如图 5- 411，在“C/C++ Build”中选择“Behavior”栏目，确保勾选“Build（Incremental Build）”选项

并输入“all CORE=n307 DOWNLOAD=ilm”。其中“CORE”选项根据实际的内核变化，这里以 n307为例。

“DOWNLOAD”选项可以修改不同的下载模式，详细请参考 5.1节，这里以 ilm 模式为例。因为例

程使用 HummingBird Evaluation Board，所以 SoC 和 Board都不必修改，如果使用其他开发板，以

RVSTAR为例，请在此处设置增加“SOC=gd32vf103 BOARD=gd32vf103v_rvstar”，并且由于 RVSTAR仅

支持 FLASHXIP模式，需要将“DOWNLOAD”设置为“flashxip”，同时“CORE”修改为“n205”。完成后点击
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“Apply”保存修改。

图 5- 41 配置 Build 选项

在完成上述操作后，打开工具链配置页，如图 5- 412，按图中配置，点击“Apply”保存修改。
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图 5- 42 配置工具链路径

编译运行以及下载的详细内容请参考 5、6 章。

6.编译工程

6.1.Nuclei SDK 工程设置工具

在 Nuclei Studio中可以通过 Nuclei SDK工程设置工具一键修改通过 Nuclei SDK Project Wizard创

建的工程的编译链接选项。本工具目前仅支持 Nuclei SDK，HBird SDK，Nuclei SoC IP SDK, 不支持无

模板手动创建的项目和基于Makefile创建的项目, 或者是自行创建维护的项目。详细使用步骤如下:

单击选中需要修改的工程，之后如图 6- 1 打开 RV-Tools>SDK Configuration Tools，可以打开修改
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编译选项的弹窗，在 2023.10版本以后，将直接打开 Nuclei Settings页面。也可以单击要修改的工

程后，如图 6- 2，点击工具栏的工程设置工具图标。或者单击要修改的工程后，键盘按下 ctrl+6。也

可以单击要修改的工程后，如图 6- 3，右击打开右键菜单，选择 SDK Configuration Tools。如图 6- 4

为工程设置工具弹窗，各选项详细功能如下：

projectName为当前选中的工程名。

Core 为当前工程对应的内核。由于工具根据 ARCH 和 ABI 选项反推出对应的内核，而不同的

内核可能有相同的 ARCH和 ABI 选项，所以显示上可能会有所偏差，只要 ARCH 与 ABI 为正

确的选项即可。此选项为方便快速切换内核选项使用。

四个勾选项：Bitmanipulation Extension(RVB), Cryptography Extension(RVK), Packed SIMD/DSP

Extension, Vector Extension(RVV) 用于选择对应的扩展指令集(B/K/P/V)，本功能在 2023.10

版本中移除，使用 Other Extensions 输入框来制定额外的扩展。

ARCH对应的当前工程的 arch选项, 根据 Core和勾选项自动组合。

ABI 对应的当前工程的 abi 选项。

Tuning根据不同级别处理器优化的 gcc 选项，选择 Core会自动选择正确的 Tuning选项，不建

议自己调整。

Code Model针对 RV32 处理器，自动选择为 Medium Low，而针对 RV64处理器自动选择为

Medium High，选择 Core以后会自动选择合适的 Code Model，其中 RV64处理器必须使用

Medium High.

Download对应当前工程的下载模式，可以切换选择不同的下载模式，目前仅 Nuclei FPGA 评

估开发板支持切换下载模式，RVSTAR仅有 FLASHXIP 模式。其中切换到 flash模式会额外定

义 VECTOR_TABLE_REMAPPED宏，其他模式不会定义这个宏

Select C Runtime Library 对应的使用标准 C库，本功能在 2023.10版本中移除。在工程创建的

时候，如果创建的工程采用的是 Newlib，则这里只能进行 newlib 版本的切换，如果创建的

工程才用的是 Nuclei C Runtime Library(libncrt)，则这里只能进行 libncrt 版本的切换。
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Optimization Level对应编译的优化等级。

Extra Common Flags 对应的是额外的通用编译选项。可以添加额外的通用编译选项。

Extra C Flags 对应的是额外的 C编译选项。可以添加额外的 C 编译选项。

Extra C++ Flags 对应的是额外的 C++编译选项。可以添加额外的 C++编译选项。

Extra ASM Flags 对应的是额外的汇编编译选项。可以添加额外的汇编编译选项。

Extra Link Flags 对应的是额外的链接选项。如果此选项已经有默认选项并且需要增加编译选项，

可以在编译选项开头或结尾处相隔一个空格字符再增加编译选项。

根据需要修改以上的选项，这里我们修改优化等级为-Os 优化生成可执行文件大小。点击 save

一键修改编译选项，save以后一定要先 clean project，之后如图 6- 5，右击修改后的工程打开右键

菜单，选择“Clean Project”清理一下工程，再点击锤子图标即可完成修改编译选项后重新编译工程。

图 6- 1 打开修改编译选项弹窗 1
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图 6- 2 打开修改编译选项弹窗 2
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图 6- 3 打开修改编译选项弹窗 3

图 6- 4 一键修改编译选项
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图 6- 5 清理工程并重新编译工程

这里的 SDK Configuration Tool切换不会对 Debug Configuration选项做任何改动，因此如果切换

了 Core以后，对应的调试配置(OpenOCD/QEMU/JLink)也需要手动修改。

需要注意的是如果要切换工程从 32位变为 64位，需要打开调试设置页面，如图 7- 11，修改

“command”中“set arch riscv:rv32”为“set arch riscv:rv64”，从 64 位切换回 32位也应当修改这里的参

数为对应的数值。

6.2.在 Nuclei Studio中编译 Hello World项目

在 Nuclei Studio中编译的步骤如下。

为了保险起见，建议先将项目清理一下。如图 6- 6所示，在Project Explorer栏中选中 hello_world

项目，单击鼠标右键，选择“Clean Project”。

如图 6- 7 所示，单击菜单上的锤子按钮，开始对项目进行编译。如果编译成功，则显示如图 6- 7

所示，能够看到生成可执行文件的代码体积大小，包括 text段、data段和 bss 段，以及总
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大小的十进制和十六进制数值。使用Makefile方式新建的工程需要在右键菜单中选择“Build

Project”进行编译。

图 6- 6 对 hello_world 项目单击右键选择“Clean Project”
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图 6- 7 单击锤子图标对 hello_world 项目进行编译

编译成功后可以看到增加了 Debug文件夹，如图 6- 8，各文件作用如下：

hello_world.elf是生成的可执行文件。

hello_world.hex是生成的 Hex文件。

hello_world.lst是生成的 list文件，可以看到反汇编和简单的代码分部信息。

hello_world.map是生成的 map文件，可以详细的看到生成的代码分布情况。
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图 6- 8 查看编译后的生成文件

7. 调试运行工程

7.1.使用蜂鸟调试器结合 OpenOCD调试运行项目

7.1.1.安装蜂鸟调试器驱动

Nuclei Studio自 2021.02 版本起 openocd实现 windows免驱功能，使用此版本及以上 windows

环境的用户可跳过此节，Linux 环境仍需配置驱动。低于此版本的用户需按照以下方法安装驱动。

7.1.1.1 在Windows 系统中安装驱动

程序编译成功后，便可以将程序下载到 FPGA原型开发板运行。首先将原型开发板与主机 PC

进行连接，步骤如下。

将蜂鸟调试器的一端插入主机 PC的 USB接口，另一端与原型开发板连接。注意：如果是第
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一次使用蜂鸟调试器，为了使得主机 PC的 Windows 系统能够识别蜂鸟调试器的 USB，需

要安装驱动，双击如图 3- 2所示的 Nuclei Studio_IDE 文件包中的 HBird-Driver.exe即可完成

此驱动的安装。

由于蜂鸟调试器还包含了“将原型开发板输出的 UART转换成 USB”的功能，因此如果蜂鸟调

试器被主机 PC识别成功（且驱动安装成功），那么将能够被主机识别成为一个 COM串口。

如图 7- 1 所示，在主机 PC的设备管理器中的“端口（COM和 LPT）栏目”中可以查询到该 COM

的串口号（譬如 COM11）。

此串口在后续的程序运行过程中将充当原型开发板运行程序的 printf输出显示接口。

图 7- 1 在设备管理器中查询 COM 串口号

注意：在通过“蜂鸟调试器”下载之前，需要注意“蜂鸟调试器”被 Windows 正确识别，检验的标

准即为本节中所述正确地安装了 HBird-Driver.exe的驱动，且能够在设备管理器中查询到 COM的串

口号。
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7.1.1.2 在 Linux 系统中安装驱动

在 Linux 环境下安装驱动步骤如下：

1：连接开发板到 Linux 中，确保 USB 被 Linux识别出来。如果使用虚拟机，如图 7- 2，确保开

发板连到了虚拟机当中。

2：在控制台中使用 lsusb指令查看信息，参考的打印信息如下：

Bus 001 Device 010: ID 0403:6010 Future Technology Devices International, Ltd

FT2232xxxx

3：控制台中输入 sudo vi /etc/udev/rules.d/99-openocd.rules 指令打开 99-openocd.rules文件，

输入如下内容，保存退出。

SUBSYSTEM=="usb", ATTR{idVendor}=="0403",

ATTR{idProduct}=="6010", MODE="664", GROUP="plugdev"

SUBSYSTEM=="tty", ATTRS{idVendor}=="0403",

ATTRS{idProduct}=="6010", MODE="664", GROUP="plugdev"

4：断开调试器再重新连接到 Linux 系统中。

5：使用 ls /dev/ttyUSB*命令查看 ttyUSB 信息，参考输出如下：/dev/ttyUSB0 /dev/ttyUSB1

6：使用 ls -l /dev/ttyUSB1 命令查看分组信息，参考输出如下: crw-rw-r-- 1 root plugdev 188, 1

Nov 28 12:53 /dev/ttyUSB1

可以看到 ttyUSB1已经加入 plugdev 组，接下来我们要将自己添加到 plugdev 组（不同

环境可能名字不同，请根据实际情况修改）。使用 whoami命令查看当前用户名，我们将

其记录为< your_user_name >。

7：使用 sudo usermod -a -G plugdev <your_user_name>命令将自己添加进 plugdev 组。加入以

后一定要重启或者注销操作系统。
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8：再次确认当前用户名已属于 plugdev 组，使用 groups 命令，可以看到打印信息中有 plugdev

即成功将当前用户添加至 plugdev组。如果没有可以尝试重启。

图 7- 2 开发板连接至虚拟机中

9：查看 gcc 的依赖是否完整

cd Nuclei Studio/toolchain/gcc/bin/

ldd ./riscv-nuclei-elf-gdb

图 7-3 查看 gcc 的依赖是否完整

如图有依赖需要安装，可以执行 sudo apt install libncursesw5 libtinfo5 进行安装

7.1.2.Debug Configuration
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7.1.2.1 使用 Nuclei Studio生成的 Debug Configuration

为了方便用户调试，Nuclei Studio在创建工程时，会根据 NPK 的配置，默认的生成 Debug

Configurations的 Launch文件。用户可以展开工程，选中对应的 test_debug_openocd.launch文件，

在右键菜单中，可以 Run as/Debug as->test_debug_openocd,就可以按照对应的 Debug Configurations

操作工程程了，具体的 Debug Configurations的内容可以在 Launch Bar 中进行详情查看。注意：配

图可能没有及时更新，导致图文不一致，以文字为准，结合对应版本进行使用。

图 7-4 Launch文件
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图 7-5 Run as/Debug as

图 7-6 在 Launch Bar 中查看 Debug Configurations



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 105

图 7-7 Debug Configurations

7.1.2.2 新建并配置 Debug Configuration

通过 Nuclei Studio新建并配置 Debug Configuration内容的步骤如下。

如图 7- 8 所示，在菜单栏中选择“Run—>Debug Configurations”。

如图 7- 9 所示，在弹出的窗口中，如果没有当前工程的调试设置内容，右键单击“GDB OpenOCD

Debugging”，选择“New”，将会为本项目新建出一个调试项目“hello_world_demo Debug”，

如图 7- 10所示。确保“Project”是当前需要调试的工程，“C/C++ Application”中选择了正确的

需要调试的 ELF文件。
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如图 7- 11所示，选择调试项目“hello_world_demo Debug”的 Debugger 菜单，在 Config options

栏目中填入-f "nuclei_sdk/SoC/evalsoc/Board/nuclei_fpga_eval/openocd_evalsoc.cfg"，以确保

OpenOCD 使用正确的配置文件。这里的配置文件

(nuclei_sdk/SoC/evalsoc/Board/nuclei_fpga_eval/openocd_evalsoc.cfg)根据实际工程中

openocd 的配置文件路径而定。例如：如果使用 makefile 方式导入工程，修改此处的内容

为-f “SoC/evalsoc/Board/nuclei_fpga_eval/openocd_evalsoc.cfg”。

如果当前内核是 RISC-V 32 位内核，请确保 Commands 内容包含 set arch riscv:rv32

如果当前内核为 64 位，应确保替换为 set arch riscv:rv64

如图 7- 12所示，选择调试项目“hello_world_demo Debug”的 Startup菜单，确保“Debug in

RAM”,“Pre-run/Restart reset”,“Set Breakpoint at Main”和“Continue”被勾选。

如图 7- 12，完成后点击右下方“Apply”保存设置。

图 7- 8 单击“Run Configuration”进行下载



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 107

图 7- 9 添加新的 GDB OpenOCD Debugging

图 7- 10 GDB OpenOCD Debugging 栏目下的 hello_world 项目 Debug
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图 7- 11 配置 hello_world_demo Debug 的参数 1
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图 7- 12 配置 hello_world_demo Debug 的参数 2

7.1.3.在原型开发板上调试程序

在开发板上调试之前，需要打开串口以便观察 Printf函数打印信息。

使用 Windows系统打开串口的方法如下：

打开 Nuclei Studio自带的串口打印通道，选择 Window>Show View>Terminal，如图 7- 13所示，

点击显示器图标打开串口设置选项。如图 7- 14所示，在其窗口中设置 Choose terminal（选

择串口，即 Serial Terminal）、“串口号”（这里以 COM11 为例）、“波特率（设置为 115200）”

等参数后，单击“OK”按钮。
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图 7- 13 通过 Nuclei Studio 打开串口调试助手并配置参数

图 7- 14 设置串口参数
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使用 Linux 系统打开串口方法如下：

打开 Nuclei Studio自带的 Terminal 终端，选择 Window>Show View>Terminal，如图 7- 13所示，

点击显示器图标打开串口设置选项。如图 7- 15所示，choose terminal 选择 Local Terminal，

点击 OK 打开 Terminal终端。如图 7- 16所示，输入“minicom /dev/ttyUSB1 115200”打开串

口，即可在 Nuclei Studio中查看串口打印信息。

图 7- 15 打开 Terminal 终端

图 7- 16 打开串口
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如果程序员希望能够调试运行于原型开发板中程序，可以使用 Nuclei Studio IDE 进行调试。由

于 IDE运行于主机 PC端，而程序运行于原型开发板上，因此这种调试也称为“在线调试”或者“远程

调试”。

这里以 1_helloworld为例，使用 Nuclei Studio IDE 对 evalsoc 原型开发板进行在线调试的步骤如

下, 注意 demosoc在 Nuclei SDK 0.5.0 中被移除，请使用 evalsoc作为替代。

确保 6.2节中的 Debug 设置内容正确，可以打开 Debug 设置选项确认。如图 7- 17所示，在

1_helloworld工程处右击，选择“Debug As –>Debug Configuration”打开 Debug 设置页面选择

之前新建的设置进行检查。

确定设置无误后，在图 7- 18的下拉框选中 Debug，之后左侧图标会变为甲虫图标，单击即可

进入调试模式并下载程序进入开发板中。

图 7- 17 单击“Debug Configuration”进行下载
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图 7- 18 切换至 Debug模式

如果下载成功，则如图 7- 19所示，并且会启动调试界面。

如图 7- 19的 1 号标注位置，这里功能包括单步，运行，汇编级调试等。

如图 7- 19的 2 号标注位置，这个箭头表示当前程序运行位置。

如图 7- 19的 3 号标注位置，在代码的左侧双击即可在该行设置断点，再次双击可以取消断点。

如图 7- 19的 4 号标注位置，这里可以切换编辑模式和调试模式。

如图 7- 19的 5 号标注位置，这里是函数内变量显示的位置。

如图 7- 19的 6 号标注位置，这里是查看寄存器数值的位置。图中显示的是 PC寄存器当前的

数值。

如图 7- 19的 7 号标注位置，点击这里红色按钮可以退出调试模式。

如图 7- 19的 8 号标注位置的下方，这里可以使用 GDB控制台指令进行调试。



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 114

图 7- 19 下载完成后进入调试界面

7.1.4.下载运行程序

调试程序没有出现问题后，可以将程序下载进开发板。如图 7- 20，点击下拉框切换至运行模式，

此时左侧图标会切换为绿色运行按键，单击即可将程序下载至开发板并运行。由于调试和下载运行

使用相同的设置文件，所以不需要再次设置。如图 7- 21，可以看到串口正确打印出 helloworld等信

息。需要断开连接，如图 7- 22，在 console栏目下点击红色按钮断开连接。
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图 7- 20 下载程序到开发板中运行
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图 7- 21 串口调试助手界面输出的 Hello World
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图 7- 22 下载完成单击红色按钮断开连接

7.2.使用 J-Link 调试运行项目

7.2.1.安装 J-Link 驱动并导入 RTT 文件

HummingBird Evaluation Board也支持使用 J-Link调试。前往 SEGGER 官网 J-Link 页面

(https://www.segger.com/downloads/jlink/#J-LinkSoftwareAndDocumentationPack)，根据自己的操作系

统下载最新的 J-Link驱动并安装。注意，J-Link的版本必须高于 v6.62版本。

如果使用串口进行打印输出，则可以略过本节后续内容。如果想使用 J-Link的 RTT 打印输出，

请按照以下步骤配置。

打开当前工程的设置页面，如图 7- 23，在“Resource”选项点击红框标注的图标快速打开工程所

在的目录。如图 7- 24，在“nuclei_sdk/SoC/evalsocsoc/Common/Source/Stubs”路径下新建一个“SEGGER”

文件夹，此文件夹用来存放 RTT 相关文件。

https://www.segger.com/downloads/jlink/
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图 7- 23 打开工程所在目录

图 7- 24 新建“SEGGER”文件夹

安装完成后打开 J-Link驱动的根目录，将“Samples -> RTT”路径下的“SEGGER_RTT_V680d.zip”解

压缩（具体压缩包名可能因版本不同而变化）。解压缩后文件内容如图 7- 25，将 RTT 文件夹下的

“SEGGER_RTT.c”，“SEGGER_RTT.h”和“SEGGER_RTT_Conf.h”三个文件以及 Syscalls 文件夹下的

“SEGGER_RTT_Syscalls_GCC.c”这些文件复制到之前新建的 SEGGER 文件夹中，最后如图 7- 26所示。

在 IDE中打开“SEGGER_RTT_Syscalls_GCC.c”，如图 7- 27，注释“#include <reent.h>”所在的这一行。
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图 7- 25 压缩包内文件内容

图 7- 26 复制后 SEGGER 文件夹内容
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图 7- 27 注释不使用的头文件

文件添加完成后添加 SEGGER文件夹路径至 include，如图 7- 28，打开当前工程的设置页面，添

加 SEGGER文件夹路径至 include 中。
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图 7- 28 添加 SEGGER 文件夹路径至 Include 中

接下来移除原有的 write函数。如图 7- 29，在“nuclei_sdk/SoC/evalsoc/Common/Source/Stubs”下

的“write.c”文件处右击，选择“Resource Configurations –> Exclude from Build”。如图 7- 30，选择“Select

All”，点击“OK”。以后如果想切换回使用串口打印，可以使用相同的方式移除 SEGGER 文件夹并把

“write.c”文件添加回工程。
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图 7- 29 打开 Exclude from Build

图 7- 30 移除 write.c 文件

7.2.2. Debug Configuration
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7.2.2.1 使用 Nuclei Studio生成的 Debug Configuration

为了方便用户调试，Nuclei Studio在创建工程时，会根据 NPK 的配置，默认的生成 Debug

Configurations的 Launch文件。用户可以展开工程，选中对应的 test_debug_jlink.launch文件，在右

键菜单中，可以 Run as/Debug as->test_debug_jlink,就可以按照对应的 Debug Configurations 操作工程

程了，具体的 Debug Configurations的内容可以在 Launch Bar 中进行详情查看。

图 7-31 Launch文件
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图 7-32 Run as/Debug as
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图 7-33 在 Launch Bar 中查看 Debug Configurations
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图 7-34 Debug Configurations

7.2.2.2 新建并配置 Debug Configuration

新建并配置 J-Link调试下载的 Debug Configuration步骤如下：

在菜单栏中选择“Run—>Debug Configurations”。

如图 7- 35，在弹出的窗口中，如果没有当前工程的调试设置内容，右键单击“GDB SEGGER J-Link
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Debugging”，选择“New Configuration”，将会为本项目新建出一个调试项目“1_helloworld

Debug”，如图 7- 36。确保“Project”是当前需要调试的工程，“C/C++ Application”中选择了正

确的需要调试的 ELF文件。

图 7- 35 新建 J-Link Debug Configuration
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图 7- 36 确保 Project 和 C/C++ Application 与工程一致

打开 Debugger栏目，如图 7- 377。

确保 1号位置“Start the J-Link GDB server locally”被选中。

2号位置正确指向 JLinkGDBServerCL.exe的路径。

3号内是当前使用的内核，这里以 N307为例，输入 N307即可。如果使用 RV-STAR 开发板，这

里输入 GD32VF103VBT6。如果使用其他开发板请参考 J-Link Support Device 网页，链接如下：

https://www.segger.com/downloads/supported-devices.php

4号选择“Interface”为 JTAG，“initial speed”为 Auto。
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5号确认与使用的 GDB设置一致。

如果有修改的内容，点击 6号位置“Apply”保存。

图 7- 37 设置 Debugger 栏目内容

打开“Startup”栏目，如图 7- 388，确保 JTAG/SWD Speed为 Auto，“set Breakpoint at main”，

“Continue”，“Pre-run/Restart reset”和“RAM application”选项被勾选，并且取消勾选“Initial Reset and

Halt”选项。
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图 7- 38 设置 Startup 栏目内容

以上设置内容完成后，如果有变动需要点击右下角 Apply 保存设置，如果没有变动点击 close

即可。

7.2.3.在原型开发板上调试程序

使用 J-Link在 HummingBird Evaluation Board调试需要连接跳线。如图 7- 39，红框标注的部分是
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J-Link需要连接到板子的部分。其中 VTref连接到板子上 V3.3 的接口，其他部分连接到 JTAG接口，

各引脚的丝印就在旁边，一一对应连接即可，最后实物连接如图 7- 40。

图 7- 39J-Link 引脚图
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图 7- 40J-Link 实物连接图

在开发板上调试之前，如果使用串口打印，需要连接 JTAG上的串口引脚到自己的主机上，再

打开串口以便观察 Printf函数打印信息。如果使用 RTT 打印，需要打开 J-Link RTT Viewer查看 printf

打印信息。如图 7- 41，按照图中内容设置，选择 USB 方式连接。Specify Target Device 根据使用的内

核来修改，这里以 N307为例。Target Interface & Speed 设置为 1000kHz，可根据实际使用情况来修

改。RTT Control Block 选择 Auto Detection。



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 133

图 7- 41 设置 RTT Viewer

图 7- 42中下拉框选中 Debug，之后左侧图标会变为甲虫图标，单击即可进入调试模式并下载

程序进入开发板中。

如果下载成功，则如图 7- 43所示，并且会启动调试界面。

如图 7- 43的 1 号标注位置，这里功能包括单步，运行，汇编级调试等。

如图 7- 43的 2 号标注位置，这个箭头表示当前程序运行位置。

如图 7- 43的 3 号标注位置，在代码的左侧双击即可在该行设置断点，再次双击可以取消断
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点。

如图 7- 43的 4 号标注位置，这里可以切换编辑模式和调试模式。

如图 7- 43的 5 号标注位置，这里是函数内变量显示的位置。

如图 7- 43的 6 号标注位置，这里是查看寄存器数值的位置。

如图 7- 43的 7 号标注位置，点击这里红色按钮可以退出调试模式。

如图 7- 43的 8 号标注位置下方，这里可以使用 GDB控制台指令进行调试。

图 7- 42 切换至下载模式



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 135

图 7- 43 下载完成后进入调试页面

7.2.4.下载运行程序

调试程序没有出现问题后，可以将程序下载进开发板。如图 7- 44，点击下拉框切换至运行模式，

此时左侧图标会切换为绿色运行按键，单击即可将程序下载至开发板并运行。由于调试和下载使用

相同的设置文件，所以不需要再次设置。如图 7- 45，可以看到 RTT Viewer 正确打印出 helloworld等

信息。如果需要断开连接，如图 7- 46，在 console栏目下点击红色按钮即可断开连接。
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图 7- 44 下载程序到开发板中运行



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 137

图 7- 45 打印输出 Hello World

图 7- 46 下载完成单击红色按钮断开连接

8. 导入旧版本 Nuclei Studio 创建的工程

8.1.Nuclei Studio 2023.10版导导入旧工程

在 Nuclei Studio 2023.10版本中，因为工具链、sdk等增均做了较大的修改，如果用户在新的

Nuclei Studio中想要使用旧版的 Nuclei Studio创建的工程，或者使用旧的 sdk，需要参考本章节内容

进行操作。

将旧的 Nuclei Studio中的工程导入到 Nuclei Studio 2023.10中时（具体导入工程的方法，可以

阅读章节 8.2内容），或者使用旧的 sdk（旧的 sdk指的是在 Nuclei Studio 2023.10发布之前所发布

的 sdk）所创建的工程，因为工程配置使用使用的是 gcc 10，当找不到对应的工具链，会出现编译

报错等问题，导致工程无法正常使用。我们提供了两种解决方案，第一种方案是手动导入 gcc 10
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工具链，第二种方案是通过 Nuclei Studio 2023.10所带的转换工具进行转换。在此推荐使用第二种

方案，能比较好的将工程转换成 Nuclei Studio 2023.10所支持的工程，并能使用其最新特性。

图 8- 1 工程导入后编译报错

8.1.1.手动导入 GCC 10 工具链

为了方便用户使用，在 Nuclei Studio 2023.10中保留了 GCC 10相关的配置，但没有将 GCC 10

打包到 IDE中，如果用户想要继续在 GCC 10 下进行开发，可以手动将 GCC 导入进来。首先，在旧

版 Nuclei Studio的安装目录中的 toolchain\gcc\ 目录找到 GCC 10 ,并将其中内容复制到 Nuclei Studio

2023.10的安装目录下的 toolchain\gcc10\内。 然后重新编译工程，工程可以正常编译，但这种方

法，Nuclei QEMU 是无法正常使用，如果有 Nuclei QEMU需求的项目，需要收到修改下 QEMU 对应

的调试配置。
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图 8- 2手动导入 GCC 10

8.1.2.通过工具将工程转换成支持 gcc 13的工程

为了方便用户导入旧的工程，并能正常使用 Nuclei Studio 2023.10特性，我们提供了快速转换

工具“Convert GCC 10 Project to GCC 13”，选中工程点击鼠标右键，在弹出的菜单中找到“Convert GCC

10 Project to GCC 13”并点击。如图 8-3，工程转换成功后，重新编译工程，此时 Nuclei Studio将调

用 GCC 13编译工程，并且 QEMU 等功能也能正常使用。

图 8- 3 Convert GCC 10 Project to GCC 13
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图 8- 4 Convert Project to GCC 13 OK

8.1.3.批量将工程转换成支持 gcc 13的工程

为了方便用户导入旧的工程，并能正常使用 Nuclei Studio 2023.10以上版本的特性，批量将工

程转换成支持 gcc 13 的工程。如图 8-5，打开转换工具，然后选择需要转换的工作，开始转换。工

程转换完成后，页面会显示转换的结果。
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图 8- 5 打开 Convert All
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图 8- 6 选择需要转换的工程
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图 8- 7 转换结果

8.2. Nuclei Studio 2022.12 之后版本导入旧工程

为了方便工程共享，Nuclei Studio 2022.12版对工程的导入做了优化，在 IDE 中将一个工程导出

后，可以双击打开*.nuproject 的方式，快速将工程在 Nuclei Studio 中导入并打开。

首先，在 Nuclei Studio 2022.12版中导出一个工程，在需要导出的工程上右键，选中 Export，

在弹出的 Export对话框中 General->File System,按向导依次操作，可以把工程导出到指定文件夹。
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图 8-5 选择 Export 菜单
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图 8-6 Export工程
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图 8-7 指定导出的目录及相应文件

其次，导入工程。查看导出的工程，可以看到工程中有一个 test.nuproject文件，点击这个文

件，就可以将工程导入到 Nuclei Studio中去了，具体的可以参考章节 5.2.2 内容。
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图 8-8 查看导出的工程

8.3. Nuclei Studio 2022.12 之前版本导入旧工程

Nuclei Studio 2023.10版本工具链名称从 riscv-nuclei-elf-gcc 更名为 riscv64-unknown-elf-gcc, 且

gcc 版本从 gcc10 升级到 gcc13。

Nuclei Studio从 2020.08 版本开始，官方工具链从 GNUMCU RISC-V GCC (riscv-none-embed-gcc)

升级到 RISC-V Nuclei GCC (riscv-nuclei-elf-gcc)，因为编译前缀发生变化，所以使用 201909及其之前

版本的 IDE生成的工程，经过调整设置后才可以在新版本 IDE 中使用。这里以 201909 版本的 Nuclei

Studio生成的 helloworld工程为例，其导入及修改设置的详细步骤如下：

导入 201909版本生成的 helloworld工程，详细的导入方式请参考 5.2 节，这里不做赘述。

导入工程后右击选择“Properties”打开设置页面，选择“C/C++ Build Settings”，打开 Toolchains

栏目然后修改 Name下拉选项为“RISC-V Nuclei GCC (riscv-nuclei-elf-gcc)”，如所示。修改后

点击 Apply保存修改。
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图 8- 9 修改 Nuclei Studio工具链

修改后右击工程选择“Clean Project”再选择“Build Project”即可。

9.Code Coverage 和 Profiling 功能

在 Nuclei Studio2023.10 版本中，集成了 Eclipse Linux Tools，并对 Eclipse Linux Tools 工具进行了

部分优化，使其可以支持 Nuclei Studio工程使用 Code Coverage 和 Profiling相关功能。

关于 Eclipse Linux Tools的详细参见

Eclipse Linux Tools: Release notes

https://github.com/eclipse-linuxtools/org.eclipse.linuxtools/blob/master/RELEASE_NOTES.md
https://github.com/eclipse-linuxtools/org.eclipse.linuxtools/blob/master/RELEASE_NOTES.md
https://github.com/eclipse-linuxtools/org.eclipse.linuxtools/blob/master/RELEASE_NOTES.md
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9.1.关于 Code Coverage 功能的使用

Nuclei Studio中的 Code Coverage 功能是借助于 gcc 编译器提供 gcov 工具来查看指定源码文件

的代码覆盖率，可以 帮助开发人员确定他们的测试用例是否足够充分，是否覆盖了被测代码的所

有分支和路径。在 Nuclei Studio 中，通 过带特定--coverage 编译选项编译指定源码文件，在实际开

发板上运行，并配合 semihost功能则可以收集需要的 coverage文件(gcda/gcno文件)， 则可以在

gcov 工具的配合下，以图形化的方式展示。

.gcno 文件是在使用 GCC 编译器的 -ftest-coverage 选项编译源代码时生成的。它包含了重

构基本块图和为 块分配源代码行号的信息。

.gcda 文件是在使用 GCC 编译器的 -fprofile-arcs 选项编译的目标文件运行时生成的。每个

使用该选项编译 的目标文件都会生成一个单独的 .gcda 文件。它包含了弧转移计数、值

分布计数以及一些摘要信息。

而一般情况下直接使用 --coverage选项就可以让指示编译器产生上述文件，注意*.gcda 文件是

运行时产生的，也 就是说需要实际运行的环境支持文件的读写才可以产生这样的文件，这里我们

采用的是 semihost技术，通过 openocd的 semihost功能，将文件写到主机上。

需要注意的是进行 coverage的时候，建议是使用 O0 编译，这样 coverage的信息才会尽可能

的准确。

关于 Code Coverage的功能详细参见

Gcov Intro (Using the GNU Compiler Collection (GCC))

Gcov Data Files (Using the GNU Compiler Collection (GCC))

Code Coverage for Embedded Target with Eclipse, gcc and gcov | MCU on Eclipse

9.2.关于 Profiling 功能

Nuclei Studio中的 Profiling 功能是借助于 gcc 编译器和 binutils 中的 gprof工具，来查看指定文

件中函数的运行时间和调 用次数，以及调用关系。gprof可以用来确定程序的瓶颈，以便进行性能

https://github.com/eclipse-linuxtools/org.eclipse.linuxtools/blob/master/RELEASE_NOTES.md
https://gcc.gnu.org/onlinedocs/gcc/Gcov-Intro.html
https://gcc.gnu.org/onlinedocs/gcc/Gcov-Data-Files.html
https://mcuoneclipse.com/2014/12/26/code-coverage-for-embedded-target-with-eclipse-gcc-and-gcov/
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优化。gprof通过在程序运行时收集数据 来工作，然后生成一个报告，该报告显示每个函数在程序

中占用 CPU时间的百分比以及函数之间的调用关系。在 Nuclei Studio中，通过带特定的编译选项--pg

编译指定源码文件，在实际开发板上运行，并配合 semihost 功能则可 以收集需要的 gmon.out文件，

在 IDE上以图形化的方式展示。

产生这个 gmon.out文件需要配合编译器并且实际上板运行，并且运行环境支持文件的读写，

才可以进行有效的 Profiling功能。

关于 Profiling的功能详细参见

Introduction (GNU gprof)

Using GNU Profiling (gprof) With ARM Cortex-M - DZone

9.3.Coverage和 Profiling功能使用

在 NucleiSudio 2023.10版中，导入对应的测试包，即可生成 Code Coverage 和和 Profiling对应

的日志文件，然后通过 Eclipse Linux Tools查看对应的 code coverage 和 profiling信息，如果需要对

应测试 demo或者具体的使用方法,请与我们联系。

https://sourceware.org/binutils/docs/gprof/Introduction.html
https://dzone.com/articles/using-gnu-profiling-gprof-with-arm-cortex-m
https://github.com/eclipse-linuxtools/org.eclipse.linuxtools/blob/master/RELEASE_NOTES.md
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图 9- 1 在 Nuclei Studio中查看 code coverage
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图 9- 2 在 Nuclei Studio中查看 code coverage

图 9- 3 在 Nuclei Studio 中查看 code coverage 直方图
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图 9- 4 在 Nuclei Studio中查看 profiling 信息

图 9- 5 在 Nuclei Studio中查看 profiling 信息



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 154

图 9- 6 在 Nuclei Studio中查看 profiling 信息直方图

10.Trace 功能的使用

Trace技术是一种强大的调试工具，它能够帮助开发人员跟踪和记录程序执行过程中的关键信

息，从而有效地诊断问题、优化性能和提升系统的稳定性。Nuclei Studio集成了 Trace 工具，结合

相对应的硬件和 Nuclei OpenOCD，用户在对工程进行 Debug 时，也可查看到 Trace 日志，并结合源

码时行问题排查。

关于 OpenOCD 的 Nuclei ETrace的一些命令，请参加 OpenOCD 下的 openocd.pdf手册。

10.1.Trace 界面介绍

在 Nuclei Studio中，通过菜单 Window->Show View->Other,打开 View管理器，在里面找到 RV

Trace->Trace 菜单，打击打开 Trace 菜单。
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图 10- 1 在 Nuclei Studio中 Trace 的视图

Trace的视图分两部分，上面为 Trace工具栏，下面是 Trace记录表格。Trace工具栏的介绍和功

能分别如下：

Trace setting

trace的配置信息，在这里配置 Trace ATB2AXI Config Addr、Trace Buffer Base Addr、Trace Buffer Size

in Bytes、Trace Wrap

Start trace/stop trace

设置开始/停止 trace操作。

Trace clear

清空硬件上的所有的 trace设置。

Dump trace file

从硬件上 Dump trace 文件。

Reload trace file

本地重新加载 trace记录表内容。

Clear viewer

清空 trace记录表内容，以及 Trace Decode相关的配置，如 HartID 和 Thread的关系等。

Save trace log
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将 trace记录表保存为 csv 表格。

Toggle instruction stepping

当选种某条记录时，可以打开并定位到该条记录所对应的源码和反汇编码。

step into previous line

当选种某条记录时，跳转到该条记录的上一条记录，并定位到所对应的源码和反汇编码。

step into next line

当选种某条记录时，跳转到该条记录的下一条记录，并定位到所对应的源码和汇编码。

Search for Addr

搜索框，可以通过 Addr 搜索到对应的那一行 trace记录。

search backward

搜索结果的记录是多条时，可以查看上一条搜索结果。

search forward

搜索结果的记录是多条时，可以查看下一条搜索结果。

Page

多页的翻页，trace如果条数很多时，为了方便查看，会采用多页显示。

Trace记录表格，是 Nuclei Studio将 dump 到的 trace文件进行解密之后，生成的记录进行展示，

并且当用户点击某条记录时，会自动定位到对应的源代码和反汇编代码的行数。

Record：记录 id

CoreId：Coreid，主要是在多核时可以用于区分不同的 Core

Addr：指令地址
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CPU Clock：时钟 Cycle计数

Clock Diff：时钟 Cycle 差

Instruction Code：十六进制表示的指令码

Instruction：指令码

File：指令码对应的源码所在的文件

File Line：指令码对应的源码所在的文件的行数

Trace Module Configuration用户可以在这里配置 Trace 的 Trace ATB2AXI Config Addr、Trace Buffer

Base Addr、Trace Buffer Size in Bytes、Trace Wrap。具体的信息，根据不同的硬件而不同。

图 10- 2 Trace setting 的视图

Trace need to be configured: 如果需要配置 Trace 模块就勾选，如果其他地方已经配置过了，就

千万不要勾选了，例如多核 SMP/AMP的情况下，SoC 上只有一个 Trace模块，假设其中一个核心已

经勾选配置了，其他的核心就不能勾选了，或者是配置是在 C 代码中或者其他地方做了，也千万不

要勾选。
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Trace ATB2AXI Config Addr：ATB2AXI 模块控制器的基地址。

Trace Buffer Base Addr：存放 trace 记录的开始地址，例如：针对某个 SoC, 举例如下 在 flashxip

模式，使用 ilm（0x1c000000）作为缓存 buffer；在 sramxip 模式，使用 dlm（0x08010000）作为缓

存 buffer。

Trace Buffer Size in Bytes：存放 trace 记录的 Buffer大小，单位为字节。

Trace Wrap：是否允许自动复盖，允许则在 Buffer满时，将再次从头开始覆盖记录。

10.2.Trace 的使用

在使用 trace功能时，必须在工程 Debug时，通过 Nuclei OpenOCD 或者 Dlink将 Trace 命令下

发到硬件，目前通过 OpenOCD，可以实现在单核、多核 SMP和多核 AMP应用下进行 Trace记录，

而 Dlink仅支持在单核应用下的 trace记录。下面我们以 OpenOCD为例，演示如何使用 Trace功能。

10.2.1.在单核应用中使用 Trace

如果您已获取到芯来授权的 CPU和相关配套硬件并准备好硬件环境，这里不详细说明。然后

创建好对应工程并确保它能在硬件上运行和调试。以下示例是在我们自己构建的一个测试环境上的

流程举例说明。

我们在这里创建了一个 N900的单核应用 helloworld，并让它跑在 FLASHXIP 模式下。
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图 10- 3 N900 的单核应用 helloworld

我们可以记录整个应用运行完的 trace，也可以记录某一段 Debug 断点之间的 trace。进入 Debug

模式后，打开 Trace视图。
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图 10- 4 helloworld 工程进入 Debug 模式
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图 10- 5 设置 Trace Configuration

设置 trace配置信息并保存(Save)，如果不想保存，就关闭窗口。Trace配置完毕后，可以设置

两个断点，一个断点用于 Trace开始点，一个断点用于 Trace结束点，在开始点断点停下后就可以

点击 start trace 按钮，就可以继续 debug操作(如单步或者运行等)了，在结束点断电停下后，就可

以点击 stop trace按钮来结束 Trace。上面只是 Start/Stop Trace的一种使用示例，也可以更灵活一些，

请根据自己需要进行使用。当 trace结束时（多核情况下请确保每个 CPU 的 Trace都结束了），就

可以点 Dump trace file按钮，将 trace文件从硬件上下载到本地，默认下载的 trace 文件存在工程目

下的 debug目录下，有一个“工程名.trace”的文件。
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图 10- 6 dump到的 trace文件

Trace文件下载完后，Nuclei Studio会弹出一个 Set current debug hart configuration框。



本文件所述内容的版权为芯来科技独家所有，未经芯来科技事先书面授权，不得传播、复制或披露本文件之全部或部分

内容。
页码 163

图 10- 7 Set current debug hart configuration

在框中填写确正信息（这里的 HartID指的是对应的 Thread的 hartid，请不要填错了）并确认，

Nuclei Studio对 trace文件开始解析，并生成 trace 记录表格。在 trace记录表格，选中任意一条记

录，Nuclei Studio会自动找到源码和反汇编码，并定位那对应的那一行（因反汇编码与源码在同一

个视图中打开，需要用户自己把反汇编码移到另一个视图中）。
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图 10- 8 trace 与源码、反汇编码联动

也可以双击“工程名.trace”文件，以文本的方式查看 trace 文件。
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图 10- 9 以文本方式查看 trace

10.2.2.在 SMP 多核应用中使用 Trace

在 SMP多核应用中使用 trace 与单核大体相似，差别在于 SMP多核在 Debug 时，不同的 thread

共用一个 Trace Configuration， 且需要通过选择不同的 Thread来对不同的 CPU Hart核心单独 start

trace/stop trace。在 Debug 视图中，点击任意一个 Thread,然后点击 Trace 工具栏中的 trace setting

来设置 Trace Configuration。
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图 10- 10 SMP 多核应用中设置 Trace Configuration

在 Debug视图中，可以通过点击不同的 Thread,来切换不同的 Core,如下图点击 Thread #1或者

Thread #1 下对应的函数名来选中对应的是 SMP多核应用中的 Core 0,可以对 Core 0 开启或者关闭

Trace，在 SMP多核应用中，只要有一个 Core 在完成 start trace操作时,Trace Configuration中的信息

就会在硬件中设置好，其他的 core在 start trace操作时，就不会重复设置 trace Configuration。
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图 10- 11 SMP 多核应用中对 Thread #1 start trace

同理，在 Debug视图中点击 Thread #2或者 Thread #2 下对应的函数名，来切换到 Core 1 上进

行 start trace/stop trace的操作。
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图 10- 12 SMP 多核应用中对 Thread #2 start trace

在 dump trace file 操作时，在 SMP多核应用中，只有当所有的 Core 都 stop trace，才可以执行

dump trace file 的指令并成功下载 Trace文件。Trace 文件的下载，在 SMP多核应用中，只需要下载

一份，在对 trace 文件进行 decoder时，注意设置 Hart ID，就可以解析出不同的 trace记录表，如下

图，当 HardID=0时，就可以查看到 Core 0 对应的 Trace 记录，同理当 HardID=1时，就可以查看到

Core 1 对应的 Trace 记录。
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图 10- 13 SMP 多核应用中查看 HardID=0 的 trace
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图 10- 14 多核应用中查看 HardID=1 的 trace

10.2.3.在 AMP 多核应用中使用 Trace

在 AMP多核应用中使用 trace也类似，trace配置也是共享。不同的 thread共用一个 trace

configuration，但可以通过不同的 thread，对不同的核单独 start trace/stop trace。如下图，在 Debug

视图，点击 Thread #1 或者 Thread #1 下的函数名，切换到 AMP多核应用中 Core 0，然后点击 Trace

工具栏中的 trace setting 来设置 Core 0 对应的 Trace Configuration。
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图 10- 15 AMP 多核应用中 Core 0 设置 trace 配置

在 Debug视图，点击 Thread #2或者 Thread #2 下的函数名，切换到 AMP多核应用中 Core 1，

然后点击 Trace工具栏中的 trace setting 来设置 Core 1 对应的 Trace Configuration，因为在 AMP多

核应用中 trace配置是共用，所以此处设置需要将 Trace need to be configured的勾去掉，表示可以

使用 trace功能，但不需要有任何设置。
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图 10- 16 AMP 多核应用中 Core 1 设置 trace 配置

Trace Configuration设置完成后，同样的通过 Debug视图的 Thread来切换不同的 Core，进行 start

trace/stop trace/dump trace file操作,注意，设置了 Trace Configuration的 Core 需要优先于其它 Core

开始 start trace，并将 Trace Configuration的信息设置好，其他的 Core才可以正常的 start trace/stop

trace/dump trace file 操作。

在 dump trace file 操作时，在 AMP多核应用中，请确定所有的 Core都 stop trace，才执行 dump

trace file 的指令，否则可能在某一下 Core在 dump trace file，其他的 Core还在记录 trace，最后得

到的 Trace文件并与预期不符。Trace 文件下载，在 AMP多核应用中，需要每一个工程应用单独 dump

一份 trace文件，其实 dump到的 trace 文件内容是一样的，在对 trace文件进行 decoder时，同样

需要注意设置 Core Hart ID，就可以解析出对应的 trace 记录表。其他操作与上文内容中所述类似。
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11.RVProf 功能的使用

RVProf是芯来科技针对 cpu cycle model 开发的性能分析工具，Nuclei Studio在 2024.02.dev版

本中，完成对 RVProf的支持。在实际使用中，RVProf功能分三步完成，首先通过 Cycle model 工具，

运行代码，产生.trace文件，然后 RVProf工具，将.trace解析成对应的.json 文件，最后通过 google

的开源工具 Perfetto Trace Viewer对.json 文件进行解析并展示。因为 cpu cycle model当前仅提供了

linux 版本，所以本文档均是在 linux 环境下演示此功能。

11.1.测试环境

cpu cycle model 在运行过程中，对硬件环境的性能要求较高，在实际使用，四核及以上的系统

中运行效果较好，一般不建议在虚拟机环境下使用。为了较好的体验效果，本测试在工作站上进行。

图 11- 1 rvprof 测试环境

11.1.1.准备测试 NPK 软件或者工具包

目前此功能仅提供测试用的 NPK 包，将相关的包安装到 Nuclei Studio 中，关于安装 NPK 包，

可以查看 Nuclei Studio手册中相关章节，因为 RVProf测试包没有公开，请联系我们索取。
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 cymodel.zip cymodel 的 NPK Tools包

 rvprof.zip RVProf 的 NPK Tools包

 Rvprof helloworld.zip 测试 demo NPK App 包

11.1.2.创建 rvprof 测试工程

创建工程前，先查看 Nuclei Package Management中 NPK是否安装正确，因为测式 demo 是依

赖于 nuclei_sdk，所以也要先安装 sdk-nuclei_sdk，具体如下：

图 11- 2 安装 RVProf 测试包及依赖包
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然后创建一个 test测试工程,在创建工程的向导中，依次 New Nuclei RISC-V C/C++ Project ->

sdk-nuclei_sdk@0.5.0 -> next,在工程配置页面，依次填写工程名、选择 Project Example：rvprof

helloworld@app-nsdkrvprof_helloworld,Nuclei RISC-V Core:N307FD（这里的 code要跟 cpu cycle model

对应）。

图 11- 3 选择最新的 nuclei_sdk

在 Project Example 可以看到我们导入的 demo NPK App中的 Rvprof helloworld 工程，选择此工

程，然后下一步，完工程的创建。
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图 11- 4 创建 RVProf 测试工程

在创建的 test工程中，可以看到多了一个 test_debug_rvprof.launch文件，rvprof相关的配置在

此文件中，可以查看内容如下。其中 Cycle Model 的 time out时间，用来设置 Cycle Model 超时时间，

因为 Cycle Model 运行时比较耗时，如果工程比较简单，可以设置一个较短的起时时间，到时间后，

可以及时中断 Cycle Model 的运行；RVProf中的超时时间的功能也是类似。
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图 11- 5 RVProf 测试工程的 launch 文件

11.2.查看 rvprof的结果

创建完工程后，在 Nuclei Studio的 launch bar上，选中 test_debug_rvprof.launch，并点击工具

栏中的运行按钮，Nuclei Studio依次完成以下任务，并将最终的结果在在 Perfetto Trace Viewer 中展

示。

 编译工程代码

 启动 Cycle Model 并产生 trace 文件

 启动 RVProf 解析 trace 文件生成 json 文件

 启动 Perfetto Trace Viewer 展示结果
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图 11- 6 Cycle Model 启动及 log 输出
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图 11- 7 perfetto启动本地服务

Perfetto Trace Viewer的官方地址是 https://ui.perfetto.dev/。Nuclei Studio默认会尝试打开

https://ui.perfetto.dev/，同时自动载入 json文件并解析。如果因为网络原因（国外服务器）打开失

败，Nuclei Studio会在本地启一个 Perfetto Trace Viewer本地服务，并自动打开本地 localhost:5000/，

此时需要用户手动载入工程目录下的Debug/test.json文件。在 Perfetto Trace Viewer中可以看到 trace

的展示结果。
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图 11- 8 打开 Perfetto Trace Viewer
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图 11- 9 手动载入 json 文件
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图 11- 10 rvprof trace 结果展示

12.使用 Nuclei QEMU 仿真调试

最新版本的Nuclei Studio整合了Nuclei QEMU，支持芯来全系列 Core的工程实现仿真调试功能，

这里以 nuclei_evalsoc工程为例。按照前文的内容新建一个 nuclei_evalsoc 工程，这里以 helloworld

工程为例，我们新建一个名为 helloworld的工程。

右击新建的工程，选择“Debug As -> Debug Configurations”打开调试设置弹窗。如图 12- 1，在弹

窗中选择“GDB QEMU Debugging”下带有“qemu”后缀的设置选项。我们工程为“helloworld”，所以此

处选择“helloworld_debug_qemu”，选中后点击右下方的“Debug”开始仿真调试。
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图 12- 1 选择 QEMU 进行仿真调试

QEMU的详细配置页，新增了 Machine Bit、Board name、Nuclei RISC-V Core、Download选项，

用户可以在这里对 QEMU进行自定义配置，详细参见 Nuclei QEMU 用户手册。

Machine Bit QEMU 可以仿真 32位和 64 位两种设备

Board name 针对不同的 Board有不同的外设及配置

Nuclei RISC-V Core QEMU已经支持当前 nuclei大多数的处理器型号，并会持续更新，支持更
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多的最新处理器的型号。下面展示了支持的 CPU型号的情况。

图 12- 2 QEMU 支持的 CPU 型号

Download QEMU 仿真了不同的下载模式

备注：

1. Nuclei Studio2023.10 版中所集成的 QEMU 对 rvstar 不再支持。

2. Nuclei Studio2023.10 版不支持 QEMU semihosting 功能，如有必要，请在命令行下使用 qemu 的

semihosting 功能。

3. Nuclei Studio2023.10 版对之前版本创建的工程的 qemu 部分不兼容，需要修改，可以参考章节

8.1.2 内容

如图 12- 2 所示，仿真调试页面与一般的调试页面完全相同，其中，串口打印信息可直接在

Console中查看。寄存器可能有部分未实现的会报错，属于正常现象。
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图 12- 3 QEMU 仿真调试界面

仿真运行流程与仿真调试相类似，右击 RVSTAR 工程选择“Run As -> Run Configurations”，弹窗

中选择“GDB QEMU Debugging”下带有“qemu”后缀的设置选项。选中后点击“Run”，可以在控制台

（Console栏）看到运行的打印输出。

13.常见问题

13.1.Nuclei Studio启动慢

Nuclei Studio是基于 eclipse进行开发，继承了 eclipse 的可扩展性的特点的是同时，也存在着

启动较慢的问题，第一次启动时，软件需要验证环境；生成常用的缓存文件；创建 Workspace.在

2021.09版的 Nuclei Studio中，我们针对启动做了优化，在电脑性能足够的前提下，第一次启动 Nuclei

Studio能在一分钟内完成。

Nuclei Studio最佳运行环境：

Windows 10 操作系统
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4G 以上内存（2G 可以被 Nuclei Studio分配使用）

13.2.Nuclei Studio编译程序很慢

在测试使用过程中，我们发现 Nuclei Studio在编译项目时会出现很慢的现像，经过排查发现，

当电脑安装 360杀毒软件时，编译指令执行很慢，退出 360杀毒软件时，编译指令可以按正常速度

执行。为了保障 Nuclei Studio的正常使用，建议在使用时退出 360等杀毒软件。

13.3.找不到 New Nuclei Risc-V C/C++ Project菜单

New Nuclei Risc-V C/C++ Project是创建工程的快捷入口，有时候如果找到不到 New Nuclei Risc-V

C/C++ Project菜单，可以在菜单Window->Perspective->Reset Perspective里进行视图重置，New Nuclei

Risc-V C/C++ Project就会重新出现。或者将当前视图切换到 C/C++视图。

图 13-1 New Nuclei Risc-V C/C++ Project 菜单
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图 13-2 视图重置

图 13-3 切换当前视图为 C/C++视图

13.4.打开/关闭 Launch Bar

Nuclei Studio2022.12 及以后的版本中，默认是开户启了 Launch Bar 功能。打开菜单栏“Window

-> Preferences”，搜索“bar”，如图 13- 4，取消勾选第一个选项即可关闭 Launch Bar。同理，想要使用

Launch Bar 功能，请勾选此选项。
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图 13- 4 关闭 Launch Bar

13.5.使用 Launch Bar

Nuclei Studio的 Launch Bar（下图中蓝色框内标注部分）是对后边下拉框中选中的调试配置对

应的工程进行编译、调试和下载等操作，如需使用此部分请注意，图标是与下拉框中调试配置内容

相绑定。下面详细介绍 Launch Bar 各部分功能：

图 13- 5Launch Bar 功能介绍

图标 1：编译选中的调试配置对应的工程。此处选中的工程为 5 号下拉框选中的调试配置对应

工程，并非 Project Explorer 中选中的工程。

图标 2：运行/调试选中的调试配置对应的工程。此处图标会根据下拉框 4的内容变化。
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图标 3：退出下载/调试模式。

下拉框 4：切换选择下载/调试模式。切换后会改变图标 2的显示内容。

下拉框 5：选中调试配置文件。此处的内容会影响图标 1、2、3 对应的工程。

齿轮图标 6：打开当前选中的调试配置页面，可直接进行修改保存。

13.6.不使用 Launch Bar进行运行/调试

对于初次新建的工程，如果不使用 Launch Bar 功能，可以右键工程，选择“Debug As -> Debug

Configurations”。在弹窗中选择工程对应的设置选项，这里以 helloworld工程为例，如图 10- 6，选择

“helloworld_debug_openocd”，之后选择“Debug”开始调试。

同理，初次运行需要右击工程，选择“Run As -> Run Configurations”。在弹窗中选择工程对应的

设置选项，之后选择“Run”开始运行。
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图 13- 6 不使用 Launch Bar 首次进行调试

若当前工程已按以上方式进行过调试或运行操作，可在上方按键中选择 的下拉选项，快速

选择对应的工程设置进行调试。对于运行，可以在 的下拉选项，快速选择对应的设置。

13.7.Debug页面查看寄存器

进入 Debug模式后，可能有些页面并不能第一时间找到，这里以查看寄存器栏目为例。在菜单

栏选择“Window -> Show View -> Registers”打开寄存器栏目。同样，如果想查看内存，可以选择

“Window -> Show View -> Memory”，想打开调试控制台，可以选择“Window -> Show View -> Debugger

Console”，其他页面此处不做过多介绍，请用户自行体验。

13.8.Debug页面结束进程

在 Debug页面要退出调试，可点击 退出调试。为防止打开多个进程导致报错，在 Debug 页

面，右击 Debug栏目中的进程，选择“Terminate / Disconnect All”关闭所有 Debug 进程。

13.9.Nuclei Studio工具栏中各按键功能

在 Nuclei Studio中，常见的工具栏图标如下，本节将依次介绍各按键的功能。

新建按键 ，包括新建各种文件和工程。

保存当前文件 和保存所有未保存文件 。

切换编译设置 ，默认只有 Debug 和 Release，用户可自行添加，这里不做介绍。

编译工程 ，可以在下拉选项中编译 Project Explorer中选中的工程。
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编译所有工程 ，一次性编译所有 Project Explorer 中的工程。

新建功能 ，包含工程创建，目录创建，文件创建和类创建。

调试 ，可根据下拉选项选择不同调试设置来调试不同的工程。

运行 ，可根据下拉选项选择不同的设置来选择不同的工程。

Profile ，使用 Profile功能，暂不支持，此处不做介绍。

用户自定义工具 ，此处不做介绍，用户可自己深入研究。

搜索工具 ，可搜索任务，文本等。

文本阅读工具 ，可以展开或折叠文本等功能。

控制台工具 ，可选择打开各种控制台或串口等。

Debug用 ，前者跳过所有断点，后者实现 Restart功能。

查看 CMSIS ，eclipse 自带功能，暂不支持。

Nuclei SDK工程设置工具 ，参见 6.6.1。
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文本阅读工具 ，可设置快速跳转，具体功能此处不作过

多介绍。

13.10.显示其他窗口

在 IDE的右上角 按键可以切换不同的显示模式，常用的是 C/C++页面和 Debug页面。其中，

在进入 Debug模式时，若不在 Debug页面，会有弹窗提示，此时点击“Switch”选项可以切换至 Debug

页面。在菜单栏中选择“Window -> Perspective -> Open Perspective”可以快速切换显示窗口。

在不同的窗口下，“Window -> Show View”显示的内容也不尽相同。如图 10- 7，在 Debug 窗口中

可以选择显示如寄存器（Registers），内存（Memory）和调试控制台（Debugger Console）。

图 13- 7 Debug 模式查看功能窗口

13.11.恢复默认窗口布局

在菜单栏中选择“Window -> Perspective -> Reset Perspective”，在弹窗中选择“Reset Perspective”
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可以恢复窗口默认布局。

13.12.对比历史文件

右击要查看历史的文件，选择“Compare With -> Local History”打开历史记录。如图 10- 8，在打开

的 History栏目双击选择要对比的文件历史版本，可以查看文件变动历史。

图 13- 8 对比历史文件

13.13.新建工程时可能出现报错

新建工程时 IDE需要索引整个工程，根据主机性能其所用时间不同。如果主机性能较差，可能

会看到索引时产生 error，索引结束后 error 会消失。如出现以上现象，请以编译时是否报错为准。

13.14.新增 Include路径出现缓存

在 include页面新增路径时，可能会出现缓存的路径内容，此时点击 Workspace或 File System
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选中后可覆盖其内容。

13.15.设置页面栏目找不到

有时可能因为弹窗大小，部分设置栏目被隐藏起来，如图 10- 9，可点击红框中左右方向图标

显示隐藏栏目。

图 13- 9 显示隐藏栏目

13.16.开发板下载速度很慢

如果遇到开发板下载速度很慢，甚至出现超时的报错，请切换至使用 USB3.0 接口，如果使用

虚拟机开发，也请同时将 USB接口设置为 3.0。

13.17.Linux环境下多用户使用 Nuclei Studio

如果需要多用户同时使用 Nuclei Studio（不推荐），用户在运行 Nuclei Studio时首先要打开菜

单栏的“Window->Preferences”。在弹窗中需要修改三个地方：
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打开“MCU->Global OpenOCD Path”，“Executable”输入“openocd”，“Folder”输入

“${eclipse_home}/toolchain/openocd/bin”。

打开“MCU->Global QEMU Path”，“Executable”输入“qemu-system-riscv32”，“Folder”输入

“${eclipse_home}/tools/qemu”。

打开“MCU->Global RISC-V Toolchains Paths”，“Default toolchain”选中“RISC-V Nuclei GCC”，

“Toolchain folder”输入“${eclipse_home}/toolchain/gcc/bin”。

修改后点击“Apply and Close”保存并关闭设置弹窗。

13.18.设备管理器中识别出两个串口

可能连接设备后在任务管理器中识别出两个串口，如图 10- 10，其中 COM编号较大的是串口打

印使用，可以使用串口调试助手等工具连接查看打印信息，但是请不要占用 COM编号较小的串口。
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图 13- 10 设备管理器中显示两个串口

13.19.Linux下使用时报 Could not determine GDB version after
sending:riscv-nuclei-elf-gdb –version,response:的错误

第一次在 linux下使用 Nuclei Studio 时，会报错 Could not determine GDB version after

sending:riscv-nuclei-elf-gdb –version,response:，如图

图 13-11 报错提示

riscv-nulcei-elf-gdb在 Nuclei studio 2023.10及之后的版本变更为 riscv64-unknown-elf-gdb。

可以使用命令 ldd $(which riscv-nulcei-elf-gdb)查看，依赖缺失

图 12-12 查看 gdb 缺失的依赖

使用命令 sudo apt install libncursesw5 libtinfo5安装相关依赖后，ide运行正常，具体可以参考
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https://github.com/riscv-mcu/riscv-gnu-toolchain/issues/9

13.20.在 linux下使用 QEMU 时报错

例如在 Ubuntu 20.04上使用 QEMU 时，可能会报错：

error while loading shared libraries: libfdt.so.1: cannot open shared object file: No such file or directory，

这是因为缺少 libfdt.so等依赖所致，只需要在对应版本的 linux 上安装对应的依赖。例如针对 Ubuntu

20.04可以使用如下命令:

安装 libfdt等依赖：sudo apt install libfdt1 libpixman-1-0 libpng16-16 libasound2 libglib2.0-0

13.21.工程编译链接 C 库找不到符号报错

因为在对 Libraries的处理中，没有能很好的处理链接之间的内部依赖关系，当使用的链接之前

互相有依赖时，可能会导至编译不通过，详细参见

https://github.com/eclipse-embed-cdt/eclipse-plugins/issues/592。解决这个问题，可以有两种办法。
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图 13- 13 因为 Libraries 内部依赖而导致的编译报错

通过调整 Libraries 的顺序或者添加多个链接来实现
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图 13- 14整 Libraries 的顺序或者添加多个链接

打开“C/C++ Build -> Settings -> Tool Settings ->GUN RISC-V Cross C++ Linker”,并修改 Command

line paatern内容，将其修改为${COMMAND} ${cross_toolchain_flags} ${FLAGS}

${OUTPUT_FLAG} ${OUTPUT_PREFIX}${OUTPUT} ${OBJS}${USER_OBJS} -Wl,--start-group $(LIBS)

-Wl,--end-group，IDE就会将 Libraries 内的内容以 group的方式处理。
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图 13- 15修改 Command line pattern内容
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图 13- 16修改 Command line paatern内容

13.22.编译工程报错 fatal error: rvintrin.h: No such file or directory

在 Nuclei Studio 2023.10中，如果使用旧的 sdk所创建的工程，如果编译时报错 fatal error:

rvintrin.h: No such file or directory，是因为在 GCC 10 时，工程中 #include <rvintrin.h>，而在 GCC 13

中，不需要再#include <rvintrin.h>，只需要删除此行，即可编译通过。
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图 13- 17 fatal error: rvintrin.h: No such file or directory

13.23.Debug时报错 Error: Couldn't find an available hardware trigger.

在 Nuclei Studio环境中，当工程在没有硬件断点的 CPU 硬件上运行时，且选择程序下载到 Flash

中运行以 Nuclei SDK为例就是(flash/flashxip DOWNLOAD模式)，可能会遇到程序 Debug无法停住的

问题，并收到错误提示：“Error: Couldn't find an available hardware trigger”。这是因为程序运行在 Flash

上，软件断点无法被成功写入，而 CPU上又没有硬件断点可以被使用，从而导致报错。
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图 13- 18 Couldn't find an available hardware trigger.

这时需要修改 Debug配置，去掉 Set breakpoint at main的勾选项，程序在运行的状态下就可以

正常中断并进行后续的单步调试。
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图 13- 19 修改 Debug 配置
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图 13- 20 修改后可以正常中断正在运行的程序并 Debug

14.Nuclei Studio 升级

一般情况下，如果 Nuclei Studio没有大的版本变动，Nuclei Studio升级工作可以由用户下载最

新的 GNU工具链以及其他相关工具和升级 IDE Plugins 的方式来完成。

14.1.GCC/OpenOCD等工具链的安装
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Nuclei Studio已经把工具链集成在 IDE 内部，工具链存放在 Nuclei Studio_IDE_XXX 文件夹内，

路径为：Nuclei Studio_IDE_XXX\Nuclei Studio\toolchain。IDE默认使用此路径的工具链，所以请不要

移动“toolchain”此文件夹，使用 IDE 创建工程后也不需要进行工具链的相关配置。

由于工具链升级的速度会比 IDE快，所以后期需要用户手动升级工具链，工具链升级方法如下：

首先删除需要更新的 GCC 或者 OpenOCD 文件内的内容，然后在芯来科技官网下载最新版本

的 GCC 或者 OpenOCD。

将 GCC 或者 OpenOCD 的内容复制到对应的文件夹下，即可完成 IDE 工具链的更新，IDE 自带

的工具链的版本号记录在 ReadMe.txt中，如图 11- 1所示。注意：要保证 gcc 所在的这一级

目录文件夹名字不变，替换后保证 bin文件夹所在层级是图中文件夹的子目录，中间不要

有其他文件夹。

图 14- 1 IDE 工具链路径

14.2.IDE Plugins 升级

Nuclei Studio支持 IDE 内在线升级，步骤如下。

如图 11- 2，打开安装软件弹窗，在菜单栏选择“Help Install New Software”。

如图 11- 3，点击“already installed”打开已安装界面。

如图 11- 4，选择“Nuclei Studio”，点击“update”即可自动完成在线更新。
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图 14- 2 打开安装软件弹窗
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图 14- 3 打开已安装界面
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图 14- 4 选择“Nuclei Studio”更新

15.创建并贡献 Nuclei Studio 组件包

Nuclei Studio 2022.04版中，提供了一个非常重要的功能，该功能主要通过提供的各种初始模板，

方便开发者去创建自己的 Nuclei Studio组件包，并可以通过平台将自己的 Nuclei Studio组件包贡献
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出来，供其他开发者使用。具体可以参考在线文档

在线文档：https://www.rvmcu.com/Nuclei Studio-userguide-id-27.html

16.其他未注明或者遇到的版本问题

如本文档中有疏漏的地方，请关注 https://www.rvmcu.com/Nuclei Studio-faq.html 这里将列出

不同版本后续遇到的常见问题。

https://www.rvmcu.com/nucleistudio-userguide-id-27.html
https://www.rvmcu.com/nucleistudio-faq.html
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